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PREFACE 

Purpose of this guide 

This guide presents an overview of current vision technologies that can provide 
students, who are visually impaired or blind, with effective and independent means of 
accessing e-text.  

SET-BC has produced narrated screen demonstrations that accompany this guide.   
See “Related Materials.”   

This guide and accompanying screen demonstrations are available on SET-BC’s web 
site at <www.setbc.org>. 

Contributors to this guide 

Introduction: Printed with permission from A. MacCuspie from “A Technology 
Handbook for Teachers of Students who are Blind or Visually Impaired” 
 
Section 1.1  Talking Word Processors 

Micki Nakashima, SET-BC Region 2, Vancouver / Southwest BC 
 
Section 1.2  Screen Magnification 

Sharon O’Dornan, SET-BC Region 1, Vancouver Island / Central Coast 
 
Section 2  E-text Research and Study Tools 

Mallory Burton, SET-BC Region 6, North Coast 
 
Section 3   Braille Notetakers 

Vicky Midtdal, SET-BC Region 3, Vernon 
Christine Purcell, Teacher of the Visually Impaired, Surrey 
Graham Hardy, student, Surrey 

 
Section 4   Screen Readers 

Dave Manzer, Teacher of the Visually Impaired, Vancouver 
 
Section 5  Production of E-text (Supported) 

Dave Rathwell, SET-BC Region 2, Vancouver / Southwest BC 
 
Section 6  Independent Production of E-text  

Dave Rathwell, SET-BC Region 2, Vancouver / Southwest BC 
Vince Tomassetti, A-T BC 

 
Editor Constance McAvoy, SET-BC Provincial Resource Team 
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ABOUT SET-BC 

Special Education Technology - British Columbia (SET-BC) is a provincial government 
initiative established to assist school districts and group 1 and 2 independent schools in 
educating students with physical disabilities, visual impairments or autism through the 
use of technology. 

SET-BC’s mandate is: 

• to lend assistive technologies where required to facilitate students’ access to 
educational programs 

• to assist school districts in providing the necessary consultation and training for 
students and educators in the use of these technologies 

 
SET-BC services to school districts include:  

• consultation, planning and follow-up for school based teams  
• loan and maintenance of assistive technology  
• training  
• provision of resources and information  
 
SET-BC consultants are based in seven Regional Centres around the province, 
providing community based services to all BC school districts. Each district has a SET-
BC District Partner who can provide information on how services are provided for eligible 
students. For more information and resources on assistive technology, check SET-BC’s 
web site at www.setbc.org. 
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INTRODUCTION 

It is easy to become overwhelmed when we think about how technology has been 
assimilated into many aspects of our lives.  The computer has become an important part of 
the way we work, play, and live.  Even those who are reluctant to incorporate the use of 
technology in their daily lives are finding it increasingly difficult to avoid technology in some 
form or another.  For example, banking and shopping, weekly tasks for most people are 
almost entirely dependent upon the use of technology.  We communicate with both business 
clients and friends using e-mail.  Sending electronic greetings (e.g., birthday wishes, 
congratulations) has become a routine practice.  Teenagers surf the web, e-mail friends, and 
talk in groups for hours on Internet-accessed “chat groups.”  A 2001 survey completed by 
Media Awareness Network reported 70% of students between the ages of 13 and 14 and 
78% of those between 15 and 17 use chat groups.  There are even special abbreviations 
and meanings assigned to the lingo used for such occasions!  In schools, most students 
work with some form of technology on a daily basis beginning in Primary.   Computers are 
used to provide and supplement instruction, practice newly learned concepts and skills, 
complete research assignments, and produce sophisticated looking reports and projects.  In 
science class, frog dissections may now be done through the use of virtual reality software. 
Even preschool settings are frequently equipped with computers containing software to 
instruct or entertain its young clientele.  In the home, computer use has become nearly as 
common as viewing television.  Software manufacturers are producing games and interactive 
software for children as young as two years of age.  Free games on CD-ROM are now 
enclosed in cereal boxes.  Family budgets, investing, and entertainment are all potential 
functions of the computer.  With the information resources available on CD-ROM and on the 
World Wide Web, the Canadian tradition of having one shelf of the family bookcase reserved 
for the multi-volume, simulated leather-bound, set of encyclopaedias is gone. 

For individuals who are blind or visually impaired, technology has opened a whole 
new world of access to print material.  I vividly recall the enthusiasm of a friend with a severe 
visual impairment when he first experienced using the World Book Encyclopaedia on CD-
ROM.  He reported having spent hours just looking things up and reading about items he had 
never before encountered or had an opportunity to read about, e.g., the Great Wall of China.  
This man is a college graduate and holds a professional position.  It is difficult to fully 
comprehend the limitations on access to information experienced by those with visual 
impairments prior to the recent advancements in technology. 

 Technology has also brought many new career opportunities for those who are blind 
or visually impaired.  Many jobs requiring ready access to print or visual information which 
were once difficult for those who were visually impaired or blind are now available because 
of the application of assistive technology such as speech access or print enlargement.  The 
field of assistive technology itself has provided numerous career opportunities in areas such 
as program development, sales, and education for those with disabilities.  For individuals 
who have disabilities in addition to a vision loss, e.g., cerebral palsy, technology has 
provided new, more effective approaches to both oral and written communication and greater 
independence.  Independence for those with a disability is a significant consideration not 
only because it increases what they can to for themselves but the personal control provided 
by such independence plays a critically important role in the development of positive self-
esteem. 

When considering the contributions technology has made in the education of children 
and youth who are blind or visually impaired, there are four further issues which warrant 
specific discussion.  First, technology has become an essential component in the 
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development of literacy for all students who are blind or visually impaired.  It is part of the 
expanded core curriculum recognized as essential programming for these students.  Koenig 
(1992) contends that when establishing standards for judging literacy, those for students who 
are blind or visually impaired must have the additional criterion of the mastery of technology 
which allows them to access and produce both print and braille documents independently.  
Whether through the use of speech access, scanners, embossers, or other hardware, 
functional literacy for students who are blind or visually impaired must be measured in terms 
of the literacy tasks they encounter daily in their home, school, community or work 
environments.  In today’s world, these literacy tasks demand the use of assistive technology. 

The second issue relevant to the use of technology and students who are blind or 
visually impaired is the tremendous potential technology has to enhance their opportunities 
for social interaction and, hence, their social development.  The Canadian Media Awareness 
Network [http://www.reseau-medias.ca/ ] is a not-for-profit organization established to 
“promote and support media education in Canadian schools, homes and communities 
through a world class Internet site.”  In a recent study, they (Media Awareness Network, 
2000) heard from 5,682 students between 9 and 17 years of age in schools across Canada.  
Daily use of the Internet from home was reported by 48% of these students.  When asked 
about their favourite things to do on the Internet, half of the items reported involved 
interaction with friends or others: 56% use e-mail, 40% use instant messaging (IM), and 39% 
participate in chat groups.  The youth of today consider interaction through technology a 
routine part of their lives.  This same opportunity must be available to students who are blind 
or visually impaired.  It exposes them to the student culture of which they need to be an 
integral part and provides them with readily available access to friends.  However, they must 
have the assistive technology and the technical expertise to take advantage of these 
opportunities. 

Courses in technology are now compulsory courses in most schools.  In larger high 
schools, students can often take quite specialized course work involving programming and 
computer assisted design (CAD).  Most students have the opportunity to take courses 
teaching web page design, graphic design and manipulation, and an array of multimedia 
applications.  Information presented in these courses provides students with skills they will 
need in a great percentage of future work environments and those required in most post-
secondary settings.  

The third issue relevant to the use of technology by students who are blind or visually 
impaired is related to the access that these students have to the computer literacy curricula 
typically available in most schools.  Teachers of students who are blind or visually impaired 
must have the expertise to assist public school technology teachers in making computer 
curricula accessible to students. 

 
If students with visual impairments are going to be competitive in the 
workplace and independent in their access of information, it is 
imperative that they have experience with a wide range of technology 
and that their instructors, if not knowledgeable themselves, have 
access to resources to facilitate instruction in and the adoption of 
technology.  (Corn & Wall, 2002, p. 207)  

The final issue is the consideration of how technology is being used in classrooms.  
In a survey of over 100 classroom teachers, MacCuspie (2002) reported that 64% of 
teachers use computers in their classrooms weekly, 28% use computers once or several 
times a day, 30 % routinely use computers to complete classroom assignments, and 33% 
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use specific software to provide instruction which is considered a compulsory part of the 
curriculum, i.e., part of the Departments of Education’s stated outcomes.  Classroom 
teachers reported using technology to provide instruction, supplement instruction, provide an 
opportunity for students to practice newly learned skills, research information, and present 
reports.  With approximately 99% of Canadian students who are blind or visually impaired 
enrolled in the regular classroom, it is critical that educators ensure these students have 
access to software used in the classroom.  These programs are becoming an integral part of 
instruction as they are more routinely used in the learning environment.  It is also critical that 
accessibility is provided in a way that ensures students have independence in their use of 
software and participation that is meaningful. 

The infusion of technology within the curriculum is presenting many challenges for 
classroom teachers (MacCuspie, 2002).  Availability of computers and software, access to 
timely technical support, time for lesson preparation, and training are frequently mentioned 
concerns.  For teachers of students who are blind or visually impaired, these issues can be 
even more daunting as they must have the basic level of computer literacy required of the 
classroom teacher as well as the expertise associated with various types of assistive 
technology used by students who are blind or visually impaired.  Undoubtedly, many may 
find this requirement an intimidating one.  Recent studies investigating the use of assistive 
technology by students with visual impairments in the regular classroom (Edwards & Lewis, 
1998; Kapperman, Sticken, & Heinze, 2002) report that one of the most influential factors 
contributing to the successful use of assistive technology by these students is the expertise 
in this area by the teacher of students who are blind or visually impaired.  This creates a 
great challenge for these teachers!  Following recent research on the use of assistive 
technology by students who are blind or visually impaired, Corn (2002) suggested that 
“teachers of visually impaired students need to develop a working knowledge of high-tech 
devices and be able to support instruction in the use of these devices while they develop an 
in-depth knowledge of a limited number of the devices their students use (pp. 208).”  While it 
is difficult to imagine what technology will bring in the next few decades, it is obvious that it 
will demand ongoing commitment to professional development for teachers of students who 
are blind or visually impaired.  If past experience with this dedicated group of educators is an 
indicator, I’m optimistic that given the opportunity for training, they’ll be leading the way. 

Printed with permission from Ann  MacCuspie from 
A Technology Handbook for Teachers of Students who are Blind or Visually Impaired 
By Ann MacCuspie, PhD 
Atlantic Provinces Special Education Authority 
Halifax, Nova Scotia 
June 2002 
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SECTION 1.1 
TALKING WORD PROCESSORS 

WRITE:OUTLOUD 

Introduction 

This section will address the needs of students with low vision who require access to 
electronic text materials.  Text materials which have been digitized into e-text can be 
accessed through talking word processors with speech and font enlargement 
capabilities. 
 
This section will focus on the talking word processor Write:OutLoud.   Issues regarding 
file formats, customization for specific needs, classroom implementation strategies, and 
identification of common barriers to use will be covered. 

Description of student need  

• Student needs enlargement of text materials and text displayed on computer screen. 
• Student needs access to curriculum materials or reference materials. 
• Student needs tools for accessing and working independently with printed materials. 
• Student may need help with reading and/or typing of text. 
• Student needs speech output to process large quantity of materials.  

Prerequisites 

• Student requires familiarity with computer and word processing skills.  
• Student requires basic operating skills for their particular talking word processor 

program. 
• Student must have hearing and auditory discrimination to be able to understand 

materials read by synthesized speech if speech feedback features are used.  Initially, 
students may have difficulty understanding, but with time, students do become 
accustomed to synthesized speech. Voice options are available that may improve 
discrimination. 

Classroom strategies 

• Provide electronic worksheets to the student with visual impairments.  Worksheets 
created by the teacher for other students can be saved as a text file on a disk and 
imported into Write:OutLoud. 

• Scan in newspaper, magazine articles and other print materials, save as a text file 
and import into Write:OutLoud. 

• Copy and Paste materials and information researched on the Internet into 
Write:OutLoud. 

• Use the Find feature to help locate keywords quickly, rather than having to read the 
entire document. 

• Use the speech to facilitate reviewing materials. 
• Use the read function to help edit own work.  Students can pick up on errors very 

quickly.  
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• Provide popular novels as e-text for independent leisure reading. There are many 
sources for electronic books.  

• For some students, Braille technology is an option that could be explored. 

Common barriers or challenges that might occur 

• In the classroom speech output will prove to be disruptive.  Earphones are simple 
solutions.   

• Availability of e-text or lack of may be an issue.  Contact your Vision Resource 
teacher to assist with access to electronic texts. 

• Staff’s lack of computer skills may be an obstacle to accessing e-text from websites 
or from scanning in text materials. 

• Difficulties will arise if two talking programs are running simultaneously. Eg. 
Write:OutLoud with ZoomText for full screen magnification.  

• Staff is not familiar with computers or with the software to be able to troubleshoot 
when problems occur. 

Team support needed to implement technology 

• The team will need to customize the software for the student’s vision and hearing 
needs.   

• For the older or more experienced user, the team will need to teach the user to 
customize features available in the software program. 

• Team will need to provide appropriate e-text from various sources. 
• Team will need to teach student how to search and download e-text files. 

System Requirements 

• Mac:  PowerMac, OS 7.6.1- 9 (not Mac OS X), 16 MB RAM, 20 MB Hard Drive 
• Windows:  Pentium/150, Win 95/98/ME/00/XP, 16 MB RAM, 20 MB Hard Drive 

Websites: 

o http://www.ibiblio.org/gutenberg/ 
o An FTP site is just a computer on the Internet that specializes in holding files for 

downloading and sending them to people on request. You can find a list of FTP 
sites that hold Gutenberg texts. 

Information and Instructions for Write:OutLoud  

E-text File Format 

Electronic or digitized text, e-text for short, is readable electronic text that may be a 
duplicate of print text such as a textbook, a novel or journal articles.  E-text also refers to 
text that is typed into a talking word processor.  E-text comes in a variety of file formats.
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Points for consideration: 

• Software programs work with different file formats.   
• Files to be opened must be compatible with the formats of that specific software 

application.   
• Write:OutLoud can open its own Write:OutLoud files, identifiable by its .wol extension 

in the filename. 
• Write:OutLoud also imports electronic text that is saved in a text file format, usually 

identified by the extension .txt in the filename. 
• Scanned-in worksheets, newspaper and magazine articles and other print materials 

can be opened by Write:OutLoud as long as they are saved in a Text (.txt) file 
format. 

• Write:OutLoud is capable of handling large text files, such as novels, text books from 
resource centres for the visually impaired, as well as from various websites. 

To Open compatible e-text files in Write:OutLoud 

o Go to FILE  OPEN 

 

o In the box below, click on the Down Arrow button in the Files of Type edit bar.  

 

o A drop down list of various file formats that are compatible with Write:OutLoud is 
displayed. 

o Select Write:OutLoud Files (*.wol) or Text Files (*.txt).  Files saved in that file 
format will be displayed.   

o Browse to select the file you want and then click on the OPEN button. 
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A shortcut to opening compatible e-text files from Windows 

• As only WOL files or Text files can be opened by Write:Outloud, there are two ways 
to determine the file format from Windows. 

1. Individual Files  
o Right Click on the file 
o Go to Properties 
o Near the top, it lists the type of file this document is. 
o It also tells you the application it opens with 

 
2. A list of documents in a folder 

o Students with visual impairments, particularly those who use the Read 
function, find it easier to view the files in List View 

o The files are listed alphabetically making it easier to read and easier to 
navigate 

o Go to VIEW and down to LIST 
o To view document type, go to VIEW, down to DETAILS 
o Now you can see very quickly which ones are WOL files, which ones are 

TEXT files and which ones are other file types. 

• Find the TEXT or WOL file you wish to open. 
• Simply drag and drop the file onto the WOL icon and it will automatically open WOL 

and the document, ready for reading. 

To Save text as a Text file 

• Saving any document as a Text file is the key in using WOL for e-text. 
• You can save articles from the Internet as a Text file for example. 
• Find the article 
• Go to FILE 
• SAVE AS 
• Go to SAVE AS TYPE edit box; see a list of available file formats. 
• Select Text File 
• SAVE 
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Accessing Text through Font Enlargement and Visual Enhancements 

For students with low vision, adjustments can be made to Write:OutLoud through font 
enlargement and visual enhancements.  

• Enlarge Font size  

o Select (highligt) text or Select All (text) under EDIT.  

 

o Click on the Grow icon  to very quickly enlarge font.   

• Set Text and Background colour for best contrast and brightness levels.   

o Select text (highlight) or Select All under EDIT and the click on the Text Colour 

icon  to scroll through the available colour options.   

o Click on the Background Colour icon  to scroll through the various 
background colours. 

o More choices for text, background and highlight colours are available with Set 
Colours under OPTIONS. 
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• Customize other Visual Enhancements under OPTIONS. 

                 

o Double or triple-spacing text. 
o Mark page breaks - often aids the student with visual clues and reference points 

to help navigate and scan the information. 
o Hide Toolbar under OPTIONS for students who require fewer distracting 

elements on the screen. 
o Highlighting text as it is read can be turned on or off under the SPEECH menu. 

 

• Settings can be saved as the default setting so these adjustments are permanent 
and do not have to be made each time Write:OutLoud is launched.  Under 
OPTIONS, select Save as Default. 

 
• For students who require magnification of the menu bars and desktop, not just the 

text, screen magnification programs, such as ZoomText, or a screen reader, such as 
JAWS should be considered. 
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Accessing text with Speech 

• Speech provides supplementary support or an alternative access for text materials. 
• Speech helps to minimize fatigue particularly for large quantity of text materials. 
• Speech facilitates understanding. 
• Speech enables students to scan text materials for specific information. 
• When font is enlarged to 48 point or larger, reading becomes cumbersome.  When 

only a few words per line and only a few lines per page are visible on the screen, 
constant scrolling and tracking back and forth is required.  Information is gained in 
small chunks and it can be difficult to integrate and make sense of the text material.  
Flow of the text and continuum of thought may be lost. 

Speech Settings in Write:OutLoud: 

• Write:OutLoud reads and repeats text. Select text to be read or Select All under 

EDIT, then click on the Read icon  or click on the Repeat icon . 

• You can stop reading at anytime by clicking on the Stop icon .   
• Highlighting text as it is read can be turned off under SPEECH for students who 

wish to simply listen. 

 
 

• For students who require some screen reading options, the tools bar can be set to 
Speak Toolbar.  Under OPTIONS, select Speak Toolbar. 
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• Choice of voices, volume setting and rate of speech feedback can be set to suit 
auditory perception to promote better listening.  Under SPEECH, go to Voice 
Settings. 

   

Keyboard navigation 

Students can use keyboard shortcuts for all functions and operations included in the 
menu or tool bar.  A list of the keyboard shortcuts is available in the User’s Guide on the 
Write:OutLoud CD. 

When font size is magnified to 36 or 48 points or higher, it is difficult to track cursor 
movements.  Keyboard control is recommended.   

Go to beginning of document CTRL HOME or icon on tool bar 
Go to end of document   CTRL END or icon on tool bar 
Go to beginning of line HOME   
Go to end of line END 
Go to next sentence CTRL SHIFT M 
Select sentence CTRL SHIFT X 

then use arrow keys, END or HOME 
keys to select text 

 
 

A “Related Materials” section is included in this resource book.  Please refer to the 
Related Materials section for a list of narrated screen demonstrations that have been 
developed for each content section. All narrated screen demonstration files are included 
on your Accessing Literacy cd, also included with this resource book. 
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SECTION 1.2 
SCREEN MAGNIFICATION 

 ZOOMTEXT 8.0 

Introduction 

This section will concentrate on the features of the screen magnification program 
ZoomText; a Magnifier/Screen reader software application for students who require 
magnification to access e-text resources.  

Description of student need 

• Student has vision loss requiring enlargement of text materials. 
• Student needs access to curriculum materials.  
• Student requires magnification of items on computer screen for access to e-text.  
• Student may also benefit from screen reader with speech output capabilities.  

Prerequisites 

• Student has basic computer, word processing and Internet skills.  
• Student is able to use keyboard commands or ZoomText “Hotkeys”. 
• Student can learn to orient herself, within a magnified environment, using context 

and the features of ZoomText.  

Classroom strategies 

• Use technology resources such as the Internet and email for instruction, providing 
accessible e-text through ZoomText. 

• Teach and review ZoomText keyboard commands to provide efficient use of 
magnification and screen-reading.  

Challenges 

ZoomText can provide access to e-text for students who have low-vision. Students may 
require alternative technology solutions, including screen-reading software such as 
JAWS. 

Team support needed to implement technology 

• Team members will customize the software for the student’s vision needs, and teach 
the student how to do this.  

• Team members must be familiar with essential keyboard commands in order to 
teach and model use of these commands. 
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Resources 

Go to www.aisquared.com to download a full-version 30-day trial of ZoomText. You can 
also request to have a CD version mailed to you. 

Information and Instructions for ZoomText 8.0 

Magnification 

ZoomText provides a magnified view of the computer screen. As the student moves the 
mouse, types text and navigates through applications, the area of activity is kept in view 
by ZoomText. 

The ZoomText toolbar shows the magnification features.  

 

The Magnifier toolbar 

 
Power   Sets the magnification level from 1x to 16x. 

 

Type   Sets the zoom window type: Full, Overlay, Lens or Docked. 
Each of these windows offers a unique way of viewing what's on the 
screen, accommodating different tasks and application environments. 

 

Adjust   Sizes or moves a zoom window. To size a window, drag any 
handle. To move a window, drag inside the window frame. Right click 
to exit the tool. Note: The Full zoom window cannot be sized or 
moved. 

 

Freeze   Freezes a portion of the full-zoom window. The Freeze 
window allows you to monitor one area of your application while 
simultaneously viewing and working in other areas. 

 

View   Shows you the area of the screen that’s currently being 
magnified (in a 1x view), and allows you to select a new area to zoom 
in on.  
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Colour   Selects colour enhancement settings. Colour 
enhancements improve screen clarity for easier viewing and reduced 
eyestrain. You can choose from a variety of preset colour schemes or 
configure your own custom colour settings. 

 

Pointer   Selects mouse pointer enhancement settings. Pointer 
enhancements make it easy to locate and follow the mouse pointer. 
You can choose from a variety of preset pointer enhancement 
schemes or configure your own custom pointer enhancements. 

  

Cursor   Select cursor enhancement settings. Cursor enhancements 
make it easier to locate and follow the text cursor. You can choose 
from a variety of preset cursor enhancement schemes or configure 
your own custom cursor enhancements.  

 

View the narrated screen demonstrations in the related materials on your ALT-VI 
resource cd. Narrated screen demonstration files have been created to demonstrate the 
following ZoomText features:  

• Magnification Options 

• Speech Output Options 
o Application Reader 
o Document Reader 

• Echo Settings 
o Typing Echo 
o Mouse Echo 
o Program Echo 

Speech Output 

Two formats for accessing e-text with speech output in ZoomText are: 

1. AppReader 

AppReader reads documents, web pages and email, within the parent application. When 
entering and exiting AppReader the view of the document does not change. 
Magnification settings remain the same as previously programmed, or can be changed 
while in AppReader.  

AppReader can be set to automatically read through the entire document, or the student 
can manually read by word, line, sentence or paragraph. As reading occurs, each 
spoken word is highlighted. AppReader settings allow the student to customize the 
appearance of word highlighting, including the highlight shape, size, colour and 
transparency level. 
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• To start and operate AppReader 
o Launch ZoomText or ensure that ZoomText is running. 
o Open the document, web page or email that you wish to read. 
o On the Reader toolbar, select AppRdr.  

AppReader begins reading from the current text cursor position. If a text cursor does 
not exist, AppReader starts paused with the first word on the page highlighted. 

Menu: In ZoomText, go to Actions menu, select Start AppReader. 

Hotkey: ALT + SHIFT + A 

 
Note:  The AppReader button and Action menu item are disabled (greyed out) when 
the last active application does not contain readable text. 

o To start and stop automatic reading, press ENTER or click the mouse.  

When using the mouse, you can resume reading from a new location by clicking 
on the word where you wish to read. 

2. DocReader 

DocReader reads documents, web pages and email, in a special environment where text 
is reformatted for easier viewing. Text is presented in a ticker tape or teleprompter 
format, with a choice of fonts, colours, word highlighting, and magnification level. 

DocReader can automatically read through an entire document, or the student can 
manually read by word, line, sentence or paragraph. As reading occurs, each spoken 
word is highlighted. 

The DocReader screen occupies the entire display with a toolbar at the top of the screen 
and the document text below it. The document text is formatted and displayed according 
to the current DocReader settings. 
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• To start and operate DocReader 

o Launch ZoomText or ensure that ZoomText is running. 
o Open the document, web page or email that you wish to read. 
o On ZoomText's Reader toolbar, select DocRdr. 

The DocReader screen appears with text from the source document. If the source 
document contains an active text cursor, the word at the cursor position is highlighted in 
the DocReader display. Otherwise, the first word in the DocReader display is 
highlighted. 

Menu: In ZoomText, go to Actions menu, select Start DocReader. 
 

Hotkey: ALT + SHIFT + D 
 
Note:  The DocReader button and Action menu item are disabled (greyed out) when the 
last active application does not contain readable text. 

o To start and stop reading, click the Play/Pause button or press ENTER.  
o While paused, click any word to set a new location to read from.  
o Keyboard commands are available for reading by word, line, sentence or 

paragraph. 
o Press the spacebar to hear a word spelled out letter.  
o To exit DocReader, right-click or press ESC. 

When DocReader exits, the text cursor is automatically positioned at the last word that 
was highlighted in DocReader (if a cursor exists). 

Other ZoomText features that provide speech output are: 

3. SpeakIt tool 

The SpeakIt tool allows you to read selected areas of the screen by clicking or dragging 
with the mouse. Any text that is visible on the screen can be spoken, even if it is outside 
the active program. Note: Text that appears in graphical images cannot be spoken. 

• To use the SpeakIt tool 

 

1. On the Reader toolbar, select the SpeakIt Tool. 
  

Menu: In ZoomText, go to Actions menu, select SpeakIT Tool. 
 

Hotkey: ALT + SHIFT + I 
  
2. To speak a single word, click on the word. 
3. To speak a block of text, drag to highlight the text.  

Upon release of the mouse button, all highlighted text will be spoken. 

4. To exit the SpeakIt tool, right-click or press ESC. 
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Note:  The SpeakIt tool can be used when speech is disabled. 

Echo Settings 

Echo settings control how ZoomText speaks as the student types, use the mouse, and 
navigates applications. These settings include: 

Typing Echo 

Typing echo allows you to hear the keys and words that you type. You can choose to 
have individual keys, words, or both keys and words spoken. Typed words are spoken 
upon completion (as soon as you type a space or punctuation character). Additional 
typing echo options also allow you to select which keys are spoken – all keys or selected 
groups of keys.  

• To enable typing echo 

 

On the Reader toolbar, select Typing, and then select the desired typing 
echo mode. 

Note:  You can switch typing echo modes using the Typing Echo 
hotkey:  ALT+SHIFT+T. 

 
Mouse Echo 

Mouse echo automatically reads text beneath the pointer. As the pointer is moved 
across the screen, single words or complete lines of text are echoed instantly or after 
hovering briefly. 

• To enable mouse echo 

 

On the Reader toolbar, select Mouse, and then select the desired mouse 
echo mode. 

Note:  You can switch mouse echo modes using the Mouse Echo 
hotkey:  ALT + SHIFT + M. 
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Program Echo 

Program echo determines what items are spoken as you navigate and use your 
applications. These items include: window titles, menus, dialogs, list views and tree 
views, and text that the cursor moves through. The amount of detail that is spoken for 
these items can be adjusted using the verbosity settings.  

 

A “Related Materials” section is included in this resource book.  Please refer to the 
Related Materials section for a list of narrated screen demonstrations that have been 
developed for each content section. All narrated screen demonstration files are included 
on your Accessing Literacy cd, also included with this resource book. 
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SECTION 2 
E-TEXT RESEARCH AND STUDY TOOLS 

KURZWEIL 3000 

Introduction 

The module E-Text Research and Study Tools will address the use of Kurzweil 3000 to 
scan, enlarge, and read documents.  Kurzweil features that will help the student with 
writing, reference, studying, filling in worksheets or forms, and test-taking will also be 
demonstrated. 

Description of student need 

• Student needs help accessing and working independently with printed materials  
• Student may have a learning disability  
• Student may need help with enlargement, reading, and/or typing of text 
• Student may need help with reference, study skills, or test-taking 

Assumptions 

Kurzweil 3000 is marketed for students with a learning disability or reading difficulty.  It 
can be used by a student with low vision if the student is able to see the Toolbars and to 
use the Highlighting Tools. 

Kurzweil 1000 is marketed for students who are blind or have visual problems.  It is 
completely accessible by ear and keyboard but has fewer features than Kurzweil 3000. 

Prerequisites 

• Physical coordination to open the scanner cover and place a document or book on 
the scanner  

• Auditory and cognitive skills to understand materials read by the computer voice 
• Capable of learning to use a dictionary, make notes, highlight important passages, 

organize materials for studying, fill in worksheets, and take tests 

Team support needed to set up and implement technology 

• Install the software and the security key for Kurzweil 
• Install the software for the scanner 
• Assist student in customizing Kurzweil according to student need 
• Assist student in learning Kurzweil 
• Troubleshoot problems that arise, particularly in scanning  
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Classroom implementation strategies 

• Quality of printed materials ensures good scanning 
• Student has access to scanner/computer even when moving from class to class 
• Teachers are well-prepared and give material to student in advance 
• Teachers allow extra time for student to scan materials 
• teachers have enough familiarity with Kurzweil to suggest how particular activities 

might be approached 

Common barriers or challenges that might occur 

• Poor quality of materials to be scanned 
• Internet access problems 
• Logistical problems with equipment (charging/transporting/space) 
• Time constraints 

Equipment needed 

• Windows desktop or laptop computer (note: a similar version is available for Mac) 
• 300 MHz Pentium Processor for regular voices, 400 MHz for RealSpeak Voices  
• 64 MB RAM, 128 MB for RealSpeak Voices  
• 300-400 MB free disk space for installation  
• 2 MB Video Ram  
• Windows 95, 98, 2000, ME, XP, NT  
• Sound Card  
• CD Drive, Floppy Drive  
• Kurzweil installation CD and activation key on floppy disk  
• TWAIN-compatible Scanner (and software) from approved list on Kurzweil website at 

www.kurzweil.edu. 

FAQ 

1. Which version of Kurzweil is best for my student? 

Kurzweil 3000 is suitable for the student who has a learning disability or reading 
difficulties.  The student also needs help with reference, study skills, and/or test-
taking.  It can be used by a student with a mild visual impairment if the student is 
able to see the Toolbars and Highlighting Tools. 

Kurzweil 1000 is suitable for a student who is blind or has a visual impairment.  It is 
completely accessible by ear and keyboard.  However, it has fewer features than 
3000. 

2. What scanner should we purchase? 

List of tested scanners appears on Kurzweil website. 
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3. Have you experienced any software conflicts? 

There have been some software conflicts with other programs that use voices.  
These can usually be solved by changing the voice or reinstalling the programs in a 
different order. 

Information and Instructions for Kurzweil 3000 

A comprehensive resource package for Kurzweil 3000, Windows version, was 
developed by SET-BC in 2003.  In the Accessing Literacy resource book, we have 
included 5 of the sections with the corresponding activities that pertain to the topic e-text 
research and study tools. The complete SET- BC resource package for Kurzweil 3000 
can be found on the Accessing Literacy resource cd that is included with this book. 

Activities:   
1. Kurzweil Startup and Toolbars 
2. Reading with Kurzweil 
3. Zone Editor/Correcting OCR 
4. Creating and Importing E-Text 
5. Kurzweil Study Tools 
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Activity 1: Kurzweil Startup and Toolbars   

Start Kurzweil:  

• Launch Kurzweil from the shortcut on the desktop.  
• Type a name in the User Name Box.  
• Read the Tip of the Day and close the Tip window.  
• Maximize the Kurzweil Window (upper right hand corner).  

Launch Kurzweil Help:  

• Click the Help icon on the Main Toolbar.  
• Maximize the Help Window.  
• Click Kurzweil 3000 Basics in the left pane.  
• Note the topics displayed in the right pane.  
• Minimize the Help Window and note its location on the Windows Taskbar.  
• Click the Help button on the Windows Taskbar to access Help during this activity if 

you need it.  

Customize the Toolbar display and size:  

• Click the right mouse button in any blank space on the Toolbar to see the Toolbars 
pop-up menu.  

• Display all four toolbars.  
• The student has a visual impairment so Main and Study Skills toolbars need to be 

large.  

Change the Toolbar Buttons:  

• Choose Customize Toolbars from the Toolbar pop-up menu.  
• Main Toolbar: add the Spell Check, Word Prediction, and Read the Web Buttons. 

(Click on the button in the Inactive Buttons window and then click Add.)  
• Main Toolbar: move the Read the Web Button to the left of the Audible button.  
• Study Skills Toolbar: add the Options Button.  

Save as a Toolbar Set:  

• In the Customize Toolbar Box, click on Save View.  
• Type a name for the Toolbar Set.  
• From the pull-down menu under View Toolbar Set, choose Basic, Apply, OK.  
• In the Customize Toolbar Box, from the pull-down menu under View Toolbar Set, 

choose your student’s custom Toolbar Set. Your settings should reappear. 
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Activity 2: Reading with Kurzweil 

Open a document to read:  

• Load the Classic Literature CD.  
• Use the Open Button on the Kurzweil Main Toolbar and navigate to the CD.  
• Choose something to read.  
• If you choose Tools/Options/General Tab and click the Speak Messages box, 

Kurzweil will read the titles for you. 

Adjust the Reading Toolbar:  

• Set the Reading Mode to Continuous and the Reading Unit to Sentence.  
• Click the Read Button on the Main Toolbar. Note that it toggles to a Pause Button.  
• Try the Back/Forward/Audible Buttons.  
• Experiment with different Reading Modes and Units.  
• Adjust the WPM to read faster or slower.  
• Adjust the Zoom level up or down.  

Customize for reading:  

• Experiment with the different background, text, and highlight colours on the 
Tools/Options/Text Tab. Don’t even think about changing all the colours to white.  

• Try the Magnifier.  
• Use Tools/Pronunciations to correct any pronunciation errors.  
• Try different voices on the Tools/Options/Reading Tab.  

Read the Web (time and network permitting):  

• Click the Web Reading button on the Main Toolbar or choose Read/Read the Web 
from the Main Menu. Your Internet browser will launch automatically.  

• Try reading a web page.  
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Activity 3: Zone Editor/Correcting OCR 

Open and Test the Document:  

• Open the document called Botany Lesson.  
• Have Kurzweil read the document and note any errors.  

Designate a Secondary Zone:  

You don’t want the page and chapter title to be read unless the student clicks on them, 
so you’re going to designate Zone 1 as Secondary Text.  

• Choose Tools/Zone Editor.  
• Click on Zone 1 to select it. (It will turn red when selected).  
• Click the right mouse button.  
• Choose Properties.  
• Click in the radio button opposite Secondary Text and click OK.  

The Zone should now be green and its reading order will be 12th.  

Reorder the Zones:  

You want the picture caption “A Typical Plant and its Parts” to be read first even though 
it’s at the bottom of the page.  

• Scroll down to the bottom of the page and select Zone 11 (it will turn red).  
• Right click the mouse and choose Properties from the pop-up menu.  
• Change the reading order to 1 and click OK. The picture caption should now be  

Zone 1.  

Test the document:  

• Choose Tools/Zone Editor to exit the Zone Editor.  
• Have Kurzweil read the document again.  

Correct the OCR:  

The caption in the upper right-hand corner, “Flower (forms fruit and seeds)” is not 
reading properly. You could have fixed it by adjusting the zone using Zone Editor, but it’s 
just as easy to fix it by correcting the OCR.  

• Click on the caption to be corrected.  
• Choose Edit/Correct OCR, Edit Underlying Text.  
• Find the mistake and click on the underlying text “rms”.  
• Change it to “(forms” and click OK.  
• Read the document again. 
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Activity 4: Creating and Importing E-Text 

Writing Text with Kurzweil:  

• Click New on the Main Toolbar to create a blank document.  
• Adjust the font, size, spacing, etc. on the Writing Toolbar.  
• Choose Tools/Options/General Tab. Experiment with different typing echo options.  
• Click the Word Prediction Button on the Writing Toolbar and try it.  
• Compose an email telling me how your Kurzweil training is going. Incorporate a few 

misspelled words.  
• Click the talking Spellcheck Button on the Writing Toolbar and try it.  
• Choose File/Send To and send your email to mburton@setbc.org.  
• Or just discard your file and quit Kurzweil.  

Using the KESI Virtual Printer:  

• Quit Kurzweil if you haven’t already done so.  
• Load the Classic Literature CD.  
• Open the first chapter of Frank Baum’s The Wonderful Wizard of Oz.  
• Choose File/Print. In the Print Dialogue Box, select the KESI Virtual Printer.  
• Kurzweil should launch; choose your User account.  
• The chapter will be created as a Kurzweil document, and you will be on the last page 

of the chapter.  

Importing Web Documents (time and network permitting):  

• Choose Online/Search for Books and experiment with downloading text from the 
Internet.  

• Launch Kurzweil Help and choose Working with Online Material in the left pane.  
• Try opening a web page and saving a text only version, referring to Help for 

instructions.  
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Activity 5: Kurzweil Study Tools 

• Open the KESI document Titanic included on your resource cd.  

Comparing Dictionaries:  

In this exercise, you are going to choose a word and compare two definitions.  

• Choose Reference/Select Dictionary/American Heritage Third Edition.  
• Highlight a word in the Titanic document and click the Definition Button. Leave the 

Definition Window open.  
• Choose Reference/Select Dictionary/American Heritage Children’s and click the 

Definition Button again.  
• Choose Window/Tile Horizontally to see all three windows and compare the 

definitions.  
• Close the definition windows and set your dictionary to your preference.  
• Try the Synonym, Syllables, and Spell Tools.  

Annotating the Text:  

In this exercise you will use the Sticky Note Tool to structure a Know/Wonder/Learn 
activity.  

• Click the Sticky Note Button on the Study Skills Toolbar and then click anywhere in 
the empty space above the title. Type the heading “KWL” and press enter. Type a 
few sentences describing what you already know about the Titanic. Type a few 
sentences describing what you wonder about the Titanic. Use the enter key to create 
new lines if your note gets too wide.  

• Click on the Voice Note icon on page 1 just to the left of the title “Sinking of the 
Titanic” to hear a message about how the document was created.  

• Record your version of “My Heart Will Go On” in a Voice Note. Or not, try adding a 
Voice Note with instructions for pre-reading.  

• Try creating a Text Note or Sticky Note by dragging and dropping a definition onto 
the page. See drag and drop in the Help index for instructions.  

Creating Bookmarks:  

• Go to the Facts Sections on page 7.  
• Highlight the words “Facts about the Wreck”.  
• Click the Bookmark Button on the Study Skills Toolbar.  
• Click Add and then OK in the Bookmarks Dialogue Box.  
• Go to the beginning of Chapter I on page 7.  
• Highlight the words “Chapter I First News” and add another bookmark.  
• Choose Edit/Find/Text in the main menu.  
• Enter the word “Chapter” in the edit field and click Find Next.  
• Add Chapter II to the Bookmarks list.  
• Repeat for Chapters III, IV, V. 
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Creating Study Notes:  

You are going to create study notes on the sinking of the Titanic by highlighting text and 
extracting those highlights.  

• Click on the Bookmark Button to take you to the “Facts about the Wreck” Bookmark. 
• Click on the Yellow Highlight Button and select some text.  
• Repeat for Chapters I through V until you have about half a page of highlights. 
• Choose File/Extract/Highlights. 
• In the extracted file, press Ctrl-A to select all of the text.  
• Click the Erase Button on the Study Skills Toolbar to remove all the highlights.  
• Add a Footnote to the extracted document, citing the source.  
• Save the document as a Word file. 
 
 
 

A “Related Materials” section is included in this resource book.  Please refer to the 
Related Materials section for a list of narrated screen demonstrations that have been 
developed for each content section. All narrated screen demonstration files are included 
on your Accessing Literacy cd, also included with this resource book. 

 
Vision Technologies: Access to Literacy - ALT-VI 2003 

Page 29 



Section 3: Braille Notetaker 

SECTION 3 
BRAILLE NOTETAKER 

Introduction 

A Braille note taker is a portable computer or personal data assistant that has a Braille 
display built onto it. These devices can be used in a stand-alone mode for taking notes, 
doing basic word-processing, scheduling appointments and performing other tasks. They 
can also be connected to a computer with screen reading software and act as a Braille 
terminal. 

“It is clear through this project that refreshable Braille can clearly be an 
integral component of an adaptive workstation. In conjunction with 
speech, refreshable Braille increases accessibility of information. Benefits 
include: reading comprehension, proof reading work, dealing with 
numerical, columnar, and tabular information, using programming code, 
and learning and reading foreign languages. Although computer tasks 
could be done with screen reading technology only, refreshable Braille 
displays proved to be more than incidental peripherals when performing 
these tasks.”   Findings from “FOSTERING INDEPENDENCE 
THROUGH REFRESHABLE BRAILLE TECHNOLOGY PROJECT” 
January 2002 - a research project funded by Human Resources 
Development Canada through the Office of Learning Technology. 
The project was an innovative partnership between the Adult Services 
Program (BC), Vancouver Community College, the University of British 
Columbia, Aroga Technologies Inc. and Freedom Scientific Inc.  

The Braille Notetaker presentation module contains the following sections: 

1.0 Using the BrailleNote to Access Electronic Text 

1.1 Using ActiveSync to Connect the BrailleNote and the PC  

1.2 Downloading an Electronic Text File and Converting It to a Word 
Processing File 

1.3 Listening To and Reading a Document  

1.4 Using the PC as a Visual Display for the BrailleNote 
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1.0  Using the BrailleNote to Access Electronic Text 

Introduction 

The module, Using the BrailleNote to Access Electronic Text, will concentrate on using 
ActiveSync with the PC and the BrailleNote to access electronic files.   

Description of student need 

The student using this type of system could address the following needs: 

• Portability 
• Compact (Disk Scan) 
• Quiet braille writer 
• Quick and easy access to the Internet without using JAWS 
• Internet access and files all in one device 
• Refreshable braille display 
• Access to a Book Reader (KeyBook) 
• Organizer (KeyPlan) 
• Compact Integrated system including: 

Word Processor (KeySoft) 
Book Reader (KeyBook) 
Calculator (KeyPlus) 
e-Mail (KeyMail) 
Address Book (KeyList) 
Internet Access (KeyWeb) 
Electronic User Manual 

• Dealing quickly with electronic files in either text or Word format 

• Easy and quick translation of text files to braille files and braille files to text files 

Assumptions 

This activity is intended for independent implementation by the student.  This session is 
not designed to teach a student how to use the Internet, therefore, his or her prior 
technology knowledge, and experience, will impact the level of independence achieved.  

This activity can be simplified by having someone other than the student, retrieve the 
information, put it on the compact flash disk, and assist the student with the insertion of  
the disk into the back of the BrailleNote and vice versa.  This will leave the student with 
only the manipulation of the BrailleNote. 
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Prerequisites 

The student will need to have: 

• Functional braille reading skills 
• Functional listening skills 
• Functional level of expertise with the BrailleNote  
• Understand how files are saved and retrieved in the Windows environment 
• Ability to remember and execute computer commands 
• Ability to understand and work on the Internet  
• Ability to hook and unhook all the cables on the BrailleNote and the computer, or use 

the infrared connections 
• Prior experience of connecting the BrailleNote and computer 

Team support needed to set up and implement technology 

The level of support required by the student will be directly related to the level of 
Internet, computer, BrailleNote, knowledge, and experience, that he or she has.  Adult 
intervention can be given at any point along the way to simplify the task.  The ultimate 
goal is to make the student as independent as possible. 

There are many ways to exchange electronic files between the BrailleNote and other 
devices.  In this session we will focus on using ActiveSync to communicate between the 
BrailleNote and the PC. 

1.1 Using ActiveSync to Connect the BrailleNote and the PC 

“The ActiveSync option in the Utilities Menu allows the BrailleNote disk drives to 
be viewed on a PC with Window Explorer. 
This feature allows file management of your BrailleNote to be performed from the 
PC.  Files and Folders can be copied, moved, or deleted, just as you would on 
the normal PC drives.  You can quickly transfer files to and from the BrailleNote 
using this option.”   (BrailleNote manual 14-1) 

Classroom implications 

• Electronic files can be transferred very quickly from the 
BrailleNote to the PC or vice versa.  This has implications in 
notes, worksheets, internet research, tests, and electronic texts. 

• Text can now be stored and accessed very efficiently and quickly. 
• No longer a need for a braille hardcopy or a transcriber.  A direct link between 

the teacher and the student. 
• Very portable in the school environment 
• Instant access to the Internet without having to deal with JAWS. 
• No longer, does the student requiring braille, need a separate room to store 

their texts and workbooks. 
• The entire system is integrated into one device. 
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Common barriers or challenges that might occur 

• The level of technology and computer knowledge and prior experience the 
student has. 

• Setting up the initial connection between the PC and the BrailleNote using 
ActiveSync. 

• Having a visual display, this requires: 

o A PC with a 9 pin serial communication port 
o Or a pocket PC with terminal emulation software 

• The BrailleNote is a little heavier than a BrailleLite 
• Setting up the Internet service provider or the network connection 
• Knowledge of computer braille when required 

o E-mail addresses 

• Canadians do not have open access to bookshare.org 
• School environment needs a technology resource person/vision teacher that 

can assist the student through the steps required to make the BrailleNote 
communicate with other devices in sharing and viewing electronic files. 

• Locating the information and technical support persons needed to assist the 
student in learning the required technology skills. 

Information and Instructions for the Braille Note 32 

Using ActiveSync to Connect the BrailleNote and the PC 

1. Ensure that the most recent version of ActiveSync has been loaded onto the 
PC (included on your BrailleNote CD) and that a prior successful connection 
has been established at least once between the BrailleNote and PC. 

 
2. With the assistance of JAWS on the PC, the student will locate, highlight, and 

copy, the section of text he/she would like to work with. 
 
3. On the PC the student will paste the information into a word processor and 

save the information as a text file.  Save this file on the desktop for easy 
access. The file can be moved later to My Documents if the student chooses 
to keep it on the hard drive. 
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4. Ensure that the 9 pin serial communications cable, pictured below, has one 
end plugged into the BrailleNote serial port and the other into the mating 
socket on the PC terminal.  If the terminal has a 25 pin D type connector 
instead, use the 9 pin to 25 pin adapter.  Ensure that the BrailleNote and the 
PC are turned on. 

 
 

5. Start ActiveSync on the PC, the following window will open on your desktop. 
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6. Under the file menu select Get Connected.  The following window appears. 
 

 
 

7. On the BrailleNote, from the Main Menu, type U for the Utilities menu.  Hit 
the space bar and Keysoft will display 

 
“Connect to ActiveSync” 

 
8. On the computer click Next in the Get Connected window.  As soon as the 

following window appears on the computer hit Enter on the BrailleNote  
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Keysoft will display  

“Utilities Menu” 
 
Don’t be fooled it is now looking for ActiveSync and will make a connection 
shortly. 
 
Note:  If you have been using the serial port for the Visual Display option, 
this must be turned off, otherwise when you connect to ActiveSync it will tell 
you that the port is not available. 
 

9. When the connection has been made your BrailleNote and PC will “chirp” 
and the following window will appear on the PC. 
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10.  As soon as the connection has been made the Partnership window below will 
open.  The default is set at yes, select No and click the Next button. 

 

 
 
You will be returned to the Microsoft ActiveSync window and you will see 
the word Connected in the Guest list. 
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11. Click on the Explore button and a window similar to the one below will open. 
 

 
 

 
 

12. Double click on the icon My Handheld PC.  The window that appears on your 
desktop is the schematic of the folders on the BrailleNote.  Files can now be 
moved back and forth between the BrailleNote and the PC just like you would 
manage them on any windows desktop.  Files should be kept in the Flash 
Disk Folder.  Note that electronic books can be kept in two locations: 1) in the 
Books folder on the KeySoft system disk, or 2) in the Flash Disk folder and 
then in the My Books folder. 

 
Note:  There may be an additional icon in this window if you have the 
compact flash disk attached to the back of the BrailleNote.  You may also 
save file to the disk where they will be permanently stored. 
Remember to save files in the Flash Disk folder and have your External 
Drive attached to the BrailleNote when copying and transferring files from the 
compact flash disk.  When you double click on the Flash Disk icon a 
window similar to the one below will open and you will then have access to 
management of your BrailleNote files on the PC.  Remember that the process 
of copying files is the same as managing files on your desktop.  
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Freeing the Serial Port  

“If you need to use the PC’s serial port for another function, go to the File 
Menu of the ActiveSync menu bar, select “Connection Settings” and un-check 
the “Allow serial cable or infrared connection to this Comm Port” option.  
Remember, that next time you connect, you have to “check” this option.”  
(BrailleNote manual page 14-4) 

1.2 Downloading an Electronic Text File and Converting It to  
a Word Processing File 

1. Navigate to the Gutenberg site by putting the name. Gutenberg in the search engine 
or by entering the following path in the box at the top of the window:  
http://gutenberg.net/. Scroll down until the following box appears on the screen. 

 

 
 
2. To download a list of all books click on Authors (ZIPped).  This will download a list 

of titles, sorted by author.  The following window will appear: 
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3. Save this file to the desktop.  When it has finished downloading, minimize your 
windows and go to the desktop.  The file on the desktop will be labelled AUTHORS.  
Double click on the file and it will extract.  For now extract it directly onto your 
desktop.  You can create a folder title Electronic Books if you so choose to do so. 

 
4. After the file has been extracted search to see if The Adventures of Reddy Fox by 

Thornton W. Burgess is available for downloading. 
 
5. Maximize the Internet Explorer window showing the Gutenberg site, and enter the 

title or author in the appropriate boxes and click on Search. 
 
6. The following window appears: 
 

 

Click on the title of your book.  It should be highlighted with a different colour.  The 
following window appears: 
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7. If you have room on your hard drive, click on the English .txt file.  It is larger; 

however, it does not have to be unzipped. 
 
8. When the Gutenberg file comes up, under the File menu, select Save As, and save it 

in My documents, and then in the folder My eBooks.  Rename the file if you desire a 
more descriptive title. 

 
9. Open the file that contains the text you just downloaded.  Notice that the file opens in 

NotePad.  Clean up the first part where the Gutenberg Project outlines their 
restrictions.  To make it easier for student to read delete all the text that comes 
before the title.  Now resave the file.  At this point you can save it into any word 
processor you choose to.  To do this, go to step #10. 

 
10. Under the Edit menu, choose Select All, or use the keyboard shortcuts CTRL-A.  

Copy this file onto the clipboard and open up the word processor you would like to 
save the file in.  Under the Edit menu, choose Paste, or use the keyboard shortcut, 
CTRL-V.  You should now see the text in your word processor and at this point you 
should save the file.  Note, at this point it will no longer be a text file, it will be 
rewritten as a Word or AppleWorks etc. file. 

 
11. If it is not already open, open the file you just saved in your preferred word 

processor.  If it is a talking word processor, select portions of the text you want read 
back to you.  If it is a regular word processor try to manipulate the text. 

 
12. Go back and download two more e-books.  If you choose you may download the 

Titles index as well. 
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1.3 Listening To and Reading a Document 

Listening to a Document 

Spacebar & G (for Go)  Read the entire document without stopping 
BACKSPACE & ENTER   Stop reading 

You can start and stop as you wish with the above two keys. 
 
SPACE with dots 1,2,3   Go to the top of the document 
SPACE with dots 4,5,6  Go to bottom of document 
 
SPACE with dot 3   Move back a character and read it 
SPACE with dots 3,6   Read current character 
SPACE with dot 6   Move forward a character and read it 
 
SPACE with dot 2   Move back a word and read it 
SPACE with dots 2,5   Read current word 
SPACE with dot 5   Move forward a word and read it 
 
SPACE with dot 1   Move back a sentence and read it 
SPACE with dots 1,4   Read current sentence 
SPACE with dot 4   Move forward a sentence and read it 
 
SPACE with dots 2,3   Move back a paragraph and read it 
SPACE with dots, 2,3,5,6  Read current paragraph 
SPACE with dots 5,6   Move forward a paragraph and read it. 

Notice the patterns:    

Left side of keyboard used for moving backward 
Right side of the keyboard used for moving forward 
Both sides used for reading current character, word, etc 
Outer fingers, on dots 3 and 6, are used to read small elements, or characters 
Inner fingers, on dots 1 and 4 are used for larger elements like sentences 
 
Hot Tip:  You do not have to release the spacebar after each command.  For 
example hold the SPACEBAR down and tap dot 2 several times to move back 
several words.  With the SPACEBAR held down, tap dot 6 several times to move 
forward several characters.  Finally release the SPACEBAR. 
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Reading a Document 

ADVANCE    Moves braille display forward one window 
BACK     Moves braille display back one window 
PREVIOUS & BACK   Move braille display one word to the left 
PREVIOUS & ADVANCE  Move braille display a word to the right 
 

1.4 Using the PC as a Visual Display for the BrailleNote 

 “ BrailleNote can provide a text output to the serial or infrared ports that reflects what the 
BrailleNote displays on the braille display or what is spoken….Sighted observers or 
teachers can use the visual display screen to view KeySoft’s prompts and help 
messages, and your text if you are typing a document.”  
(BrailleNote manual page 2-10) 

 
1. The first thing that you must check is to make sure the program Hyperterminal is 

installed on your computer.  It usually can be found in the Start Menu under 
Programs/Accessories/Communications/Hyperterminal.  If it is not, it can be 
downloaded from the Internet and installed on your PC. 

 
2. Ensure that the 9 pin serial communications cable, pictured below, has one end 

plugged into the BrailleNote serial port and the other into the mating socket on the 
PC terminal.  If the terminal has a 25 pin D type connector instead, use the 9 pin to 
25 pin adapter.  Ensure that the BrailleNote and the PC are turned on. 

 

 
 
3. On your PC start the Hyperterminal program.  The New Connection window will 

open.  Type in BrailleNote for the Name and leave the default icon selected.  Click 
OK. 
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4. The Connect To window will open.  In the Connect using drop down menu select, 
Direct to Com 1.  Click OK. 

 

 
5. The Com 1 Properties window will open.  Under the Bits per second drop down 

menu, select 38400.  Click OK. 
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6. The following window will open. 
 

 
 

7. On the BrailleNote open the Options Menu (SPACE with O) then type V for Visual 
display.  KeySoft will display 

 
“Visual display off” 

 
8. To send the visual display to the Serial port type S followed by ENTER.  KeySoft will 

display 
 

 “Serial” 
 
and take you back to the Main Menu.  You will now see the visual display of the 
BrailleNote on the Hyperterminal screen.  It will look similar to the window below. 
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9. It is very important to remember to turn the Visual Display back to Off when you are 
finished, especially if you are planning on using Active Sync or connecting to JAWS 
with the BrailleNote. You need to free up the serial port currently being used for the 
Visual Display.  In the Options Menu, select V for Visual Display.  KeySoft will 
display 

 
“Visual display serial” 

 
Type F followed by ENTER to turn the visual display off.  KeySoft will display 
 

“Off” 
 

and return you to the Main Menu.  You will no longer be able to view text in the 
BrailleNote Hyperterminal window. 
 
Note: When you close Hyperterminal you will be asked if you want to save the 
BrailleNote Connection settings.  Respond yes to this and an icon will be put into 
the Hyperterminal menu.  The next time you connect just double-click on the 
BrailleNote icon and the settings will have been saved for you. 

Equipment needed 

• BrailleNote with KeySoft 5.0.  
• Smartscan 
• Compact Flash Disk 
• 9 pin serial communication cable 
• Computer with 9 pin serial communication port 
• Access to the Internet 
• MicroSoft ActiveSync loaded onto the PC 
• Desk and powerbars 
• Access to a printer and required cables 
 
Note:  The biggest support is in the availability of a vision teacher or technology 
consultant that can assist the team in finding the required information and then 
knowing how to make it all work together.  The second biggest impact on support 
is the student’s knowledge and prior experience in computer and BrailleNote 
skills. 

FAQ 

1. What if I just can’t get the connections to work? 
 
Call the technicians at the PulseDate center.  Have all your equipment 
available, plugged in, and ready when you call for support. 1-925-681-4636 
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2. What are the disk drives that you can access with the BrailleNote? 

• Compact Flash - refers to the small disk that can be inserted in the back of 
the BrailleNote and into the SmartDisk Drive. 

• Flash Disk – storage area within the BrailleNote 
• Keysoft System Disk – cannot save to this disk it is for the operating 

system of the BrailleNote 

3. Where can I get e-text from? 
 

There are many sites available through the Internet.  You need only put 
electronic books or electronic texts in the search engine and many sites will 
appear.  Some are free and some are to purchase.   
 
Example of some sites are listed below: 
 

http://gutenberg.net/
http://www.bookshare.org/web/Welcome.html
http://www.ipl.org/div/books/
http://www.free-books.org/
http://www.stockton.lib.ca.us/ebooks.htm#free
http://www.downloadfreetrial.com/educational/e-books.html
http://www.bartleby.com/
http://etext.lib.virginia.edu/ebooks/ebooklist.html
http://www.memoware.com/
http://www.bibliomania.com/
http://www.learningpage.com/free_pages/ewe_preview.html
http://www.classicbookshelf.com/library/
http://digital.library.upenn.edu/books/search.html
http://integratingtheinternet.com/index/primary3.html#art
http://www.night.net/tucker/
http://schools.sd68.bc.ca/fore/enrichment.htm
http://kidsdomain.com/down
http://www.sd22.bc.ca/hillview/prod/govres.htm

 
 
 

A “Related Materials” section is included in this resource book.  Please refer to the 
Related Materials section for a list of narrated screen demonstrations that have been 
developed for each content section. All narrated screen demonstration files are included 
on your Accessing Literacy CD, also included with this resource book. 
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RESOURCES 

This BrailleNote resources module contains the following sections: 

2.0 The BrailleNote 32 Notetaker 

2.1 The BrailleNote 32 Book Reader  

2.2 BrailleNote 32 Book Reader Lesson 1  

3.0 The BrailleNote Word Processor  

3.1 The BrailleNote Word Processor  Lesson 1 

3.2 The BrailleNote Word Processor  Lesson 2 

3.3 The BrailleNote Word Processor  Lesson 3 

 

2.0 The BrailleNote 32 Notetaker  

A Braille note taker is a portable computer or personal data assistant that has a Braille 
display built onto it. These devices can be used in a stand-alone mode for taking notes, 
doing basic word-processing, scheduling appointments and performing other tasks. They 
can also be connected to a computer with screen reading software and act as a Braille 
terminal. 

Classroom implications 

• Electronic files can be transferred very quickly from the BrailleNote to the PC or vice 
versa.  This has implications in notes, worksheets, internet research, tests, and 
electronic texts. 

• Text can now be stored and accessed very efficiently and quickly. 
• No longer a need for a braille hardcopy or a transcriber.  A direct link between the 

teacher and the student. 
• Very portable in the school environment 
• Instant access to the Internet without having to deal with JAWS. 
• No longer, does the student requiring braille, need a separate room to store their 

texts and workbooks. 
• The entire system is integrated into one device. 
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Common barriers or challenges that might occur 

• The level of technology and computer knowledge and prior experience the student 
has. 

• Setting up the initial connection between the PC and the BrailleNote using 
ActiveSync. 

• Having a visual display, this requires: 

o A PC with a 9 pin serial communication port 
o Or a pocket PC with terminal emulation software 

• The BrailleNote is a little heavier than a BrailleLite 
• Setting up the Internet service provider or the network connection 
• Knowledge of computer braille when required 

o E-mail addresses 

• Canadians do not have open access to bookshare.org 
• School environment needs a technology resource person/vision teacher that can 

assist the student through the steps required to make the BrailleNote communicate 
with other devices in sharing and viewing electronic files. 

• Locating the information and technical support persons needed to assist the student 
in learning the required technology skills. 

Equipment needed 

• BrailleNote with KeySoft 5.0.  
• Smartscan 
• Compact Flash Disk 
• 9 pin serial communication cable 
• Computer with 9 pin serial communication port 
• Access to the Internet 
• MicroSoft ActiveSync loaded onto the PC 
• Desk and powerbars 
• Access to a printer and required cables 

Note:  The biggest support is in the availability of a vision teacher or technology 
consultant that can assist the team in finding the required information and then knowing 
how to make it all work together.  The second biggest impact on support is the student’s 
knowledge and prior experience in computer and BrailleNote skills. 

FAQ 

1. What if I just can’t get the connections to work? 

Call the technicians at the PulseDate center.  Have all your equipment available, 
plugged in,  and ready when you call for support. 1-925-681-4636 
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2. What are the disk drives that you can access with the BrailleNote? 

• Compact Flash - refers to the small disk that can be inserted in the back of the 
BrailleNote and into the SmartDisk Drive. 

• Flash Disk – storage area within the BrailleNote 
• Keysoft System Disk – cannot save to this disk it is for the operating system of 

the BrailleNote 
 
3. Where can I get e-text from? 

There are many sites available through the Internet.  You need only put electronic 
books or electronic texts in the search engine and many sites will appear.  Some are 
free and some are to purchase.   

Example of some sites are listed below: 

http://gutenberg.net/
http://www.bookshare.org/web/Welcome.html
http://www.ipl.org/div/books/
http://www.free-books.org/
http://www.stockton.lib.ca.us/ebooks.htm#free
http://www.downloadfreetrial.com/educational/e-books.html
http://www.bartleby.com/
http://etext.lib.virginia.edu/ebooks/ebooklist.html
http://www.memoware.com/
http://www.bibliomania.com/
http://www.learningpage.com/free_pages/ewe_preview.html
http://www.classicbookshelf.com/library/
http://digital.library.upenn.edu/books/search.html
http://integratingtheinternet.com/index/primary3.html#art
http://www.night.net/tucker/
http://schools.sd68.bc.ca/fore/enrichment.htm
http://kidsdomain.com/down
http://www.sd22.bc.ca/hillview/prod/govres.htm
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2.1 The BrailleNote 32 Book Reader  

KeyBook “enables you to read electronic books in any standard Braille or text format 
including MICROSOFT Word format….you can read using the Braille display or listen as 
KeyBook reads out loud…” 
“If the book is in text format, KeyBook can translate the text into your preferred reading 
grade instantly, as you read….The underlying text is still in its original form…” 
*** Braille files can only be read in the grade in which they were created. 
The electronic book cannot be edited in KeyBook. 
For this exercise the introduction from the Gutenberg files has been removed to make 
the book reading easier. 

2.2 BrailleNote 32 Book Reader Lesson #1 

In this lesson the student will access electronic books from locations other that the 
“Books” folder in the KeySoft System Disk and in both text and Microsoft Word format. 

NOTE:  For this lesson the electronic book(s) should be transferred by the teacher onto 
the student’s compact flash disk.  Some samples from the Gutenberg site 
(www.gutenberg.net) have been included to assist you with this lesson.  The forward 
has been removed in the electronic book for ease of reading for the student.  A copy of 
their forward is included at the end of this lesson. 

1. From the Main Menu select Book Reader the quick way by brailling the letter “b”.  
You may also access the Book Reader by scrolling through the options (pressing the 
spacebar and backspace on the Braille keyboard or using the Back and Advance 
thumbkeys) at the Main Menu until you hear “Book Reader” and then press ENTER.  
Keybook will prompt: 

“Read book in which folder?  Press ENTER for (KeyBook will suggest the last 
folder that was opened or says NONE) 

2. Press Backspace to change the current drive. Remember you can do this 
any time you are prompted for a folder name.  KeyBook will prompt: 

Drive?  Press ENTER for (KeyBook will prompt the last drive used) 

If your prompt was not Compact Flash scroll through the choices using either the 
thumbkeys or Braille keyboard and press ENTER when the Compact Flash is 
prompted. 
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3. KeyBook will prompt: 

“Read book in which folder?  Press ENTER for None.” 

Press ENTER since our first book we will read is not in a folder.   

4. KeyBook will prompt: 

“Book name.  Press ENTER for (KeyBook will give you the name of the first book 
on the list).  Computer Braille is required.” 

Scroll through the choices until you hear The Adventures of Reddy Fox.txt and 
press ENTER. 

5. KeyBook will prompt: 

“Review the Options?” 

Braille the letter “n” for No. 

You will hear the Braille display changing and the BrailleNote will beep once or twice 
indicating it is busy loading the book.  Once the book is loaded if you have not read it 
before, KeyBook will prompt: 

“Top of Document. The”  (KeyBook will always read the word or what appears in 
the first cell if it is a space or punctuation) 

6. Use either the refreshable braille display with the thumbkeys to read some of  
the text or the braille keyboard commands to listen to some of the text, or a 
combination of both. 

Refer to the file Listening To and Reading a Document for the list of 
commands.  

7. When you are finished, press SPACE and E to exit and save your place in the book. 
When you reopen this book it will automatically take you to the place where you left 
off. 
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8. On the PC the student will paste the information into a word processor and save the 
information as a text file.  Save this file on the desktop for easy access. The file 
can be moved later to My Documents if the student chooses to keep it on the hard 
drive. 

 

9. Ensure that the 9 pin serial communications cable, pictured below, has one end 
plugged into the BrailleNote serial port and the other into the mating socket on the 
PC terminal.  If the terminal has a 25 pin D type connector instead, use the 9 pin to 
25 pin adapter.  Ensure that the BrailleNote and the PC are turned on. 
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10. Start ActiveSync on the PC, the following window will open on your desktop. 

 

11. Under the file menu select Get Connected.  The following window appears. 

 

12. On the BrailleNote, from the Main Menu, type U for the Utilities menu.  Hit the 
space bar and Keysoft will display 

“Connect to ActiveSync” 

13. On the computer click Next in the Get Connected window.  As soon as the following 
window appears on the computer hit Enter on the BrailleNote  
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Keysoft will display  

“Utilities Menu” 

Don’t be fooled it is now looking for ActiveSync and will make a connection shortly. 

Note:  If you have been using the serial port for the Visual Display option, this must 
be turned off, otherwise when you connect to ActiveSync it will tell you that the port 
is not available. 

14. When the connection has been made your BrailleNote and PC will “chirp” and the 
following window will appear on the PC. 

 

15.  As soon as the connection has been made the Partnership window below will open.  
The default is set at yes, select No and click the Next button. 
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You will be returned to the Microsoft ActiveSync window and you will see the word 
Connected in the Guest list.   

 

16. Click on the Explore button and a window similar to the one below will open. 
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17. Double click on the icon My Handheld PC.  The window that appears on your 
desktop is the schematic of the folders on the BrailleNote.  Files can now be moved 
back and forth between the BrailleNote and the PC just like you would manage them 
on any windows desktop.  Files should be kept in the Flash Disk Folder.  Note that 
electronic books can be kept in two locations: 1) in the Books folder on the KeySoft 
system disk, or 2) in the Flash Disk folder and then in the My Books folder 

Note:  There may be an additional icon in this window if you have the compact flash 
disk attached to the back of the BrailleNote.  You may also save file to the disk 
where they will be permanently stored. 

Remember to save files in the Flash Disk folder and have your External Drive 
attached to the BrailleNote when copying and transferring files from the compact 
flash disk.  When you double click on the Flash Disk icon a window similar to the 
one below will open and you will then have access to management of your 
BrailleNote files on the PC.  Remember that the process of copying files is the same 
as managing files on your desktop.  

 

 

Freeing the Serial Port  

“If you need to use the PC’s serial port for another function, go to the File Menu of the 
ActiveSync menu bar, select “Connection Settings” and un-check the “Allow serial 
cable or infrared connection to this Comm Port” option.  Remember, that next time 
you connect, you have to “check” this option.”  (BrailleNote manual page 14-4) 
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3.0  The BrailleNote Word Processor  

This lesson will introduce the BrailleNote word processor, KeyWord.  At the end of the 
lesson the student will have a basic understanding of creating, editing and reading a 
simple document. 
The default for KeyWord is a braille document, with the automatic layout and format for 
a braille page embossing directly.  A braille document can be sent “to an ink printer or 
another computer or e-mail it, and KeySoft automatically translates it into a suitable 
format.”  
You can create a text document with the layout and format for an ink-print page.  A text 
document can also be embossed using automatic braille translation. 
“KeyWord allows you to format a document for embossing and independently format the 
same document for printing.  The two sets of formatting controls are independent….The 
document remains unchanged when you send it to an embosser or printer. 

Word Processor - KeyWord 

KeyWord Menu 

• Create a Document 
• Open a Document 
• Emboss a Document 
• Print a Document 

You can select an item by scrolling through the options and when you arrive at the 
prompt you are looking for, press ENTER.  You can also select options quickly by 
brailling the first letter of the option when you are in the KeyWord menu. 
i.e. “c” will take you quickly to Create document. 
Documents: Each file must be identified by a unique name allowing KeySoft to 
distinguish one file from another.  “A name may be up to 250 characters long, and can 
contain any braille sign.” You can use spaces and Grade One or Two braille in your 
filename. When opening an existing document the exact unique name must be used. 
Folders: To help you organize your files, documents can be stored in groups called 
folders.  Initially the BrailleNote comes with folders named “General”, “Work”, 
“Manual” (contains the User Manual), and a number of others which the KeySoft 
system uses.  You can create as many folders as you wish, using up to 250 characters 
in the name and any braille signs. You can use spaces and Grade One or Two braille in 
your filename. 
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Drives: (there are 3 drives)  

• KeySoft System Disk – You cannot save files here as this is used for the 
information provided originally from the factory and what makes the BrailleNote 
operate, think of it as the BrailleNote operating system. 

• Flash Disk – Memory within the BrailleNote that you would usually store files for 
fast, secure storage.  “You can copy, rename, erase or edit and re-save documents 
to the Flash Disk.”  

• Compact Flash – refers to the small disk that can be inserted in the back of the 
BrailleNote or into the SmartDrive, for access to other computers with a USB port. 

Hot Tip: You may find it helpful to print a hardcopy of the file Listening To and 
Reading a Document to have a list of commands available to you while doing 
these exercises with your student. 
 
 
Changing the Current Drive 
You can change the drive anywhere in the BrailleNote. When you are at the prompt for a 
filename or folder name, press BACKSPACE.  KeySoft prompts: 
 
 “Drive? (last drive used)” 
 
To scroll through the list of available drives press the thumbkey ADVANCE or SPACE 
on the braille keyboard.  To select a drive press the thumbkey NEXT or on the braille 
keyboard, ENTER. 
 
You have 3 options for drives if you have the storage card in the back of the BrailleNote: 

• Compact Flash - refers to the small disk that can be inserted in the back of the 
BrailleNote and into the SmartDisk Drive. 

• Flash Disk – storage area within the BrailleNote 
• Keysoft System Disk – cannot save to this drive as it is for the operating system 

Hot Tip: The Compact Flash Disk has a little lip to it.  The lip goes down when 
placing it into the BrailleNote.  The lip goes to the left when inserting it into the 
SmartDisk drive.  If you share this with your students it will assist him/her in 
inserting the disk properly into both devices.  It does take a bit of pulling to 
extract the disk from the BrailleNote, it sometimes helps to GENTLY rock it to the 
left and right.  Do not be concerned. 
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3.1 The BrailleNote Word Processor Lesson #1 

Note:  Please use the listening and reading commands at any time in these exercises to 
reinforce their use.  They are listed for you in the document titled Listening To and 
Reading a Document, included with this tutorial. 

In this exercise you will create a new file called Spelling.  You will enter some words and 
sentences, Save the file and then exit. 

1. From the Main Menu braille the letter “w” to get to the word processor quickly.  If you 
forgot what letter to braille, you could scroll through the options with the thumbkeys 
or braille keyboard and select KeyWord by pressing NEXT or ENTER. 

KeySoft prompts: 

“KeyWord menu” 

2. Scroll through all the options in the KeyWord menu by using the thumbkeys or 
braille keyboard. When you hear the prompt, “End of Menu”, braille the letter “c” to 
quickly select, Create a document. Press ENTER or NEXT to select it.  KeySoft 
prompts” 

 
“Drive? Press ENTER for (last drive used)” 
 

3. Locate the COMPACT FLASH if it is not prompted and press ENTER. 
 
KeyWord will prompt: 

 
 “Folder Name?  Press ENTER for NONE”.  Press ENTER. 
 

4. KeyWord prompts:   
 

 “Document to Create?” 
 

 Call this file “spelling”. KeyWord does not use caps to search documents.   
 **Notice that the braille display shows the name of your file and uses cells 7 & 8 to 

shows you  where the character you type will be entered (cursor).  Use Grade One or 
Two braille.  Press ENTER.  KeyWord prompts: 

 
  “Spelling.Top of Document. Blank.” 

You are now at the top of a blank braille document.  Braille in the following spelling 
lesson: 
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NOTE:  For now, to keep this lesson simple, if brailling mistakes are made use the 
backspace key, just like you would on a computer, to delete the text.  Use the 
buttons at the top of each cell to route your cursor to the point you want in the text 
and then use the backspace key to delete.  
 

BrailleNote 
document 
compact Flash 
advance 
enter 
next  
space 
thumbkeys 

keyboard 

1. If I want to scroll through the list in a menu, I can use the thumbkeys or the 
braille keyboard. 

 
2. If I want to select an option I press Enter on the braille keyboard or the 

thumbkey, Next. 
 

3. (Leave this line blank.  We will come back to fill it in, in lesson 2) 
 
5. Your document is automatically saved; however, it is always a good habit to return to 

the Main Menu before powering down.  This automatically saves your files even if the 
battery should go completely flat.  Do this now by brailling the letter “e” and pressing 
the spacebar at the same time. Keysoft will prompt: 

 
“Exit. KeyWord menu.” 
 

Use the thumbkey Previous to return to the Main Menu.  
 
Note:  There are many ways to navigate back to the Main Menu using the 
thumbkeys, braille keyboard, or a combination of both as in the above example. 
Each student will develop their own pathways that suit them best. 

 
Vision Technologies: Access to Literacy - ALT-VI 2003 

Page 61 



Section 3: Braille Notetaker 

3.2 The BrailleNote Word Processor Lesson #2 

This lesson teaches the student to open a previously created file, add to it, and translate 
it to a Word file for the teacher. 

Note:  Please use the listening and reading commands at any time in these exercises to 
reinforce their use.  They are listed for you in the document titled Listening To and 
Reading a Document, included with this tutorial. 

Insure that the student’s compact flash disk is in the BrailleNote as you will be opening 
the file Spelling created in Lesson 1. 

1. Open the word processor by brailling the letter W from the Main Menu.  KeySoft will 
prompt: 

 
“KeyWord menu.” 
 

2. Braille the letter O to Open a Document.  KeyWord will prompt: 
 

“Drive?  Press ENTER for (suggested drive).” 
 

Note: The BrailleNote always defaults to the last drive used for quick access to the 
last file you were working on.   
 

3. If KeySoft did not prompt the COMPACT FLASH DISK, use the SPACEBAR or 
ADVANCE thumbkey to scroll through the three drive options. Press ENTER or 
NEXT thumbkey to select the drive.  KeySoft will prompt: 

 
 “Folder Name?  Press ENTER for (suggested folder)”  i.e.NONE 
 

4.  Press ENTER.  KeySoft prompts: 
 

“Document to Open?  Press ENTER for (suggested file)” 
 

 Note: The BrailleNote always defaults to the last file used for quick access. 
If Spelling was not suggested scroll through the options using the SPACEBAR or 
ADVANCE thumbkey until you hear Spelling.  Press ENTER or NEXT thumbkey to 
open the file. 
 

5. Keysoft will place you back in your document where you left off.  In this case at the 
bottom of the spelling exercise.  Keysoft should prompt: 

 
“3 period” 
 

You are now ready to add the following text for the third sentence. 
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6. If I want to exit any menu, I can braille the letter E and press the spacebar  at the 
same time. 

 
NOTE:  For now, to keep this lesson simple, if brailling mistakes are made use the 
backspace key, just like you would on a computer, to delete the text.  Use the 
buttons at the top of each cell to route your cursor to the point you want in the text 
and then use the backspace key to delete. Simple editing will be addressed in the 
next lesson. 
 

7. Return to the Main Menu when you have finished entering the third sentence for the 
spelling exercise. 

 
8. You will now use the following directions to translate your Keysoft file to a Word file 

so that you may hand it into your teacher for correction and comments. 
 
9. From the Main menu, type F to open the File Manager, type T for the Translation 

menu, type E for Export Document.  Keysoft will prompt: 
 

“Drive?  Press Enter for (last disk used)” 
 

If the suggestion for the drive was not COMPACT FLASH scroll through the options 
and select this drive.  Keysoft will prompt: 
 

“Export Document from which folder?  Press ENTER for (none).” 
 

Keysoft may also reverse these two prompts depending on where you were last 
working on your BrailleNote. 
 

10. Keysoft will prompt: 
 

“Document Name?  Press Enter for (suggested document).” 
 

11. Using the SPACEBAR or ADVANCE key scroll through until you locate the file you 
want to translate.  Press ENTER to select the file.  Keysoft will prompt: 

 
“Export to which device?” 
 

12. Type F for File type.  Keysoft will prompt: 
 

“Export as which File type? ASCII text file?” 
 

13. Type SPACE with dots 3,4 repeatedly until you hear Microsoft Word file and press 
ENTER.  Keysoft will prompt: 

 
“Destination Drive? Press Enter for (suggested drive).” 
 

NB If the suggested drive is not the COMPACT FLASH scroll through the choices 
until you hear it announced. 
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14. Select Compact Flash by pressing ENTER. Keysoft will prompt: 
 

“Directory Name?  Press Enter for slash.  Computer Braille is required.” 

15. Press ENTER.  Keysoft will prompt: 

“Destination FileName?  Compuer Braille is required.”  

16. Type in the name of new Microsoft Word file you want to create. For example you 
could call it “Spelling (today’s date)”.  Press ENTER.  Keysoft will prompt 

“1 file Exported.  Translation Menu.” 

17. You may now return to the Main Menu and remove the compact flash from the 
BrailleNote and insert it into the  SmartDisk drive and attach it to your teacher’s PC 
through the USB port.  In My Computer,  double click on the Removable Disk and the 
teacher will see your file.  It can be opened in Word.  The teacher can correct it, add 
to it, save it and then return it to the student.  They would open it in the regular way 
through the word processor. 

Refer to pages 12-16 and 12-17 in the user manual for additional information.  
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3.3  The BrailleNote Word Processor Lesson #3 

This lesson will teach the student how to open a Word file in Keysoft and some basic 
editing features.   

Note:  Please use the listening and reading commands at any time in these exercises to 
reinforce their use.  They are listed for you in the document titled Listening To and 
Reading a Document, included with this tutorial. 

Insure that the file Homework!  Oh, Homework! has been copied onto your students 
Compact Flash Disk using the computer to do this and the SmartDisk. 

1. From the Main Menu open the word processor quickly by typing in the letter W. 
 
2. Braille the letter O to Open a Document.  When prompted for the drive please select 

the Compact Flash.  When prompted for the Folder Name select None.  Keysoft 
will prompt: 

 
“Document to open?” 
 

Use the SPACEBAR to scroll through the choices until you hear Homework!  Oh 
Homework! and press ENTER on the braille keyboard to open the file.  Keysoft will 
prompt: 
 

“Review the options?” 
 

3. Type the letter Y for Yes. Keysoft will prompt, 
 

“Translate into Braille? Currently (suggestion)” 
 

4. Type Y for Yes and press Enter.  Keysoft will prompt: 
 

“End of list” 
 

5. Press SPACE and E to exit and go to the top of the document to begin reading 
and/or editing.  KeySoft will prompt: 

 
“Exit. Top of Document. Homework!”  
(KeyWord always prompts what is at the beginning of the file) 
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6. You are now at the top of the document and we will be editing the text for errors. 

Please read the following poem to the student before beginning the exercise in order 
for him/her to know what corrections to make. You may even want to print out a 
braille copy for some of the students to refer to. 

 
Homework!  Oh, Homework! 
By Jack Prelutsky 
Homework!  Oh, Homework!  
I hate you!  You stink! 
I wish I could wash you 
away in the sink, 
if only a bomb 
would explode you to bits. 
 
Homework!  Oh Homework! 
You’re giving me fits. 
 

This is the student file for editing: 
 

Homework!  Oh, Homework! 
By Jack Prelutsky 
Homewrk!  Oh, Homewrk!  
I hate you!  You sftink! 
I wish I could wash wash you 
away in the stink, 
if only a bmb 
would explode you explode to bits. 
Hoomework!  Oh Hmework! 
You’re giving me  
 
fits. 
 

7. Use the refreshable braille display to read and edit the text.  Use the thumbkeys 
ADVANCE and BACK to move the braille display one line forward or backward at a 
time. 

 
8. “To insert a character, word, sentence, or any amount of text, you need only to 

position the cursor at the point where you want to insert the text, and start typing.  No 
special command is required because KeyWord is always in insert mode.”  
Remember that the little grey keys above each cell are used to route the cursor to 
the point in the text where you want to edit.  For example in the first line of text to 
correct Homewrk is missing an o.  Position the cursor on the r  and then braille the 
letter o.  Do the same for the second Homewrk. 
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9. There are two ways of deleting. For this exercise we will be using the Quick 
Commands. Please refer to page 3-17 & 3-18 in the manual for using the Delete 
Menu. The full set of delete command is: 

 
 Backspace   press the BACKSPACE key on its own 
 Delete current character BACKSPACE with dots 3,6 
 Delete current word  BACKSPACE with dots 2,5 
 Delete previous word  BACKSPACE with dot 2 
 Delete to end of sentence BACKSPACE with dots 1,4 
 Delete to end of paragraph BACKSPACE with dots 2,3,5,6 
 Delete to end of document BACKSPACE with dots 4,5,6 

Note:  Notice that the above commands “correspond to the Read commands, but 
use the BACKSPACE key instead of SPACE.  For example, “Read current 
character” is SPACE with dots 3,6, so “Delete current character” is BACKSPACE 
with dots 3,6.” 

10. In the second line of the poem the letter f must be removed from the word sftink. 
Place the cursor on the letter t and press the BACKSPACE key. The BrailleNote will 
give a little beep to indicate the delete is finished. 

 
11. In the third line of the poem the word wash is written twice.  Position the cursor 

anywhere in the word and press BACKSPACE with dots 2,5 to delete the current 
word.  The BrailleNote will beep to let you know that the delete is complete and the 
cursor moves to the beginning of the next word. 

 
12. Continue to edit the remainder of the poem.  When you are finished use the read all 

command SPACEBAR and the letter G, to read the edited poem. 
 
Hot Tip:  “On reading your document again, you may find a word misspelled.  
When using speech it is often simpler to delete the word and rebraille it 
correctly, followed by a single space, rather than delete one or two characters 
and correct on a letter by letter basis.” 
 

13. If you made any alterations to the file when you exit by using SPACE and E Keysoft 
will prompt: 

 
“Exit.  Document was modified.  Save as a KeyWord Document?” 
 

14. If you wanted to save this file as a braille file, type Y for Yes.  Keysoft prompts: 
 

“Document name?  Press Enter for (suggestion).” 
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15. Enter the new name and press Enter.  Keysoft now returns you to the KeyWord 
menu. 

 
If you have not altered the document when you exit by using SPACE and E, 
Keysoft will prompt: 
 

“Document was translated into Braille.  Save as a KeyWord Document?” 
 

16. Type Y if you want to save the document.  This would mean you would not have to 
translate it every time you wanted to open it.  e.g. tests, reading assignments.  
Keysoft will prompt: 

 
“Document name?  Press Enter for (suggestion).” 
 

17. Enter a new name for the braille file and press Enter.  Keysoft now returns you to the 
KeyWord menu. 
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SECTION 4 
SUPPORTING LITERACY WITH JAWS 

Introduction 

JAWS is an essential component of a complete literacy program for all Braille users.  
Some teachers may feel that a Windows computer is unnecessarily complex for a young 
student who is learning Braille.  We have found it effective to start with a refreshable 
Braille note taker like the Braille Note and then add JAWS and a Windows computer 
once the student is ready to proceed.  Many students successfully move into JAWS at 
the same time as they make the transition into the Intermediate grades.  The staff who 
are concerned about the complexity of JAWS are often quite relieved once they begin 
teaching JAWS.   While I understand their concern I feel that it may be based on a lack 
of accurate information.  Much of the often cited massive number of JAWS commands 
are in reality Windows from the keyboard commands.  If presented in a structured 
manner these commands, though numerous, are in fact quite manageable. 

If we wish to provide access to the full range of literacy building activities then JAWS will 
be required so that the student may independently access Windows, a full-featured word 
processor (MS Word), E-text (MS Word), the Internet (Internet Explorer), email 
(OutLook), presentation software (PowerPoint) and on-line encyclopedias (Grolier’s).  
Given the breadth of this topic each area will be discussed briefly with reference made to 
resources and supports rather then being described in detail. 

Regarding JAWS and Literacy, although there is a lot of information to cover, given the 
resources within JAWS, the online resources at www.setbc.org and other sites like 
Kathleen Beaver’s at Buffalo (http://atto.buffalo.edu/registered/Tutorials/jaws/index.php), 
when it is systematically introduced and taught, JAWS is an essential component of a 
complete literacy system for every Braille user. 

In this module, I will provide information on JAWS and a variety of Literacy activities. 
Implementation strategies and other ways to support the student will also be shared.   

Information and Instructions for Windows – Mouse Free, MS Word, and 
JAWS with EText, Internet, and Grolier’s Encyclopedia 

1. Windows From The Keyboard – Mouse Free  

Windows 98, ME, or XP is the system that makes your computer operate. It is called 
Windows because within the screen there are rectangular frames or windows that 
contain programs or documents. It is possible to have many windows showing on the 
screen at one time, and to work with them at the same time. (For blind students it is 
easiest to have only one window visible on the screen at a time – maximize current 
application window and document window.) Windows is a graphical operating system 
(GUI - graphical user interface). That means programs, menus and commands are 
represented by pictures and buttons on the screen. For the sighted user program 
pictures (icons) are double clicked on with the mouse to activate them. One click selects 
the icon and the second one chooses (or activates) it. Menus and commands (on-screen 
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buttons) are also typically graphical in that once clicked on, buttons depress or menus 
open.  

The Windows Operating System was developed so that all functions and commands 
could also be activated from the keyboard. For the purpose of understanding how a 
student who is blind will learn to use their computer, the emphasis in this presentation, 
will be on understanding Windows concepts, and navigation from the keyboard.  In 
Windows there are often many ways to achieve the same result.  It is essential that the 
way that is taught is the way that is most likely to support the student’s understanding of 
Windows, its programs and file management.  When you navigate using the keyboard 
you will notice that certain things (menu headings, icons etc.) will be highlighted 
(selected). This is referred to as the "focus". This term will be used throughout the 
presentation.  

The Windows operating system has certain conventions that are useful to understand. 
For the mouse user these conventions may not be readily evident.  

Windows contains two programs that allow the user to explore the hard drive and find 
out what programs and files it contains. The first is called Windows Explorer. It can 
show all of the folders and files on each drive in one window. The other program is My 
Computer. It shows only the folders and, when chosen, the files are displayed in a new 
window. It is highly recommended that students navigating from the keyboard become 
familiar with Windows Explorer, as the navigation within a single window is much easier. 
However, most mouse users will use My Computer because it is conveniently located on 
the desktop. 

Create New Folder  

A folder is a place where related files are stored. For students, folders are most often 
created to hold files that are related by subject. New folders can stand alone in the Tree 
View as a direct branch of the C: drive or they can be created within existing folders.  

Before making a new folder make sure that you know where you are making it. Folders 
can get lost when made inside of other folders if you are not careful. It is generally 
recommended not to have any more folders within folders than necessary, as finding 
them becomes increasingly difficult especially for the beginner.  

Place a Shortcut to a File or Folder on the Desktop 

It is sometimes useful to place a shortcut to a file, folder, or program on the desktop 
(although users who are blind often avoid the desktop due to the time it takes to navigate 
it).  

Placing a Shortcut on the Start Menu  

Another way to open a file or program is to place the shortcut on the Start Menu. To do 
this select the shortcut you have made on the desktop and drag it to the Start Menu 
button. It should appear after that at the top of the Start Menu. A program will only run if 
you have made the shortcut to the application’s executable file (.exe file). If it is a 
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shortcut to a file you have put on the Start Menu, both the application and the file will be 
opened.  

Creating a Hotkey  

You can create a hotkey so that a program will open using keyboard commands rather 
than the mouse. To do this you must first find the .exe file for the program. Then you can 
make a shortcut to it and place it on the desktop. You can then select the shortcut and 
use the keyboard command for a right mouse click (SHIFT+F10) and from the 
"properties" menu item create a hotkey command set to open the program.  

Also see Appendix A: Windows Navigation 

2. Microsoft Word from the Keyboard 

While most users are familiar with Microsoft Word using the mouse, pull-down menus 
and toolbars, it is completely accessible from the keyboard.  It can be accessed quite 
simply with a minimum of commands.  The ALT key and the Menus will allow the 
beginner to accomplish any writing task that the beginner may wish to do.  Gradually 
accelerator keys and toolbars can be introduced so as to reduce the learning demands. 

Accelerator Keys 

In addition to the keyboard commands (e.g. ALT + f; then n to open a new document) 
many word processing commands can be executed immediately by pressing CONTROL 
+ a designated letter. These "Accelerator keys" are noted in the pull down menus next to 
the menu item. Common ones are CONTROL + N to create a new document, 
CONTROL + O to open a document, CONTROL + S to save a document, and 
CONTROL + P to print a document (although there are others that will be noted later). It 
is important to note that the accelerator keys will only work when executed directly from 
the document. They will not work if the menu bar has the focus or if a menu is open.  

The Toolbar  

Word processing programs also have toolbars to execute common tasks. While there 
are many possible toolbars to choose from (see View menu/Toolbars submenu) the two 
most common ones are the Standard and the Formatting toolbars. Younger low vision 
students may find that the Standard Toolbar makes for easier access because it reduces 
the amount of memorization required (i.e. rather than remember CONTROL + P, they 
just click the toolbar icon). The JAWS user will most commonly prefer the "formatting 
toolbar".  

To get to a toolbar first change the focus to the Menu Bar by pressing the ALT key, then 
press CONTROL+TAB. This moves the focus to the toolbar. You can now use the Arrow 
keys to go across the toolbar.  Note that all toolbar actions are also available through the 
menus and many can be made using accelerator keys e.g. CONTROL+B to make 
selected text bold. To see these formatting and text attribute commands see the section 
on Windows Editing Commands that follows. Formatting changes will be in effect 
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immediately (center, justify). Editing and attribute commands (cut, paste, bold, italics 
etc.) will affect only text that has been selected first.  

Word Help can be accessed any time by pressing F1. It is organized in exactly the same 
manner and has the same features as Windows Help. The "index" tab is the most useful.  

Also see Appendix B: MS WORD 

3. JAWS 

JAWS (Job Access With Speech) is a screen review program produced by Freedom 
Scientific (www.freedomscientific.com) that recognizes all text based information on the 
computer screen and converts it to spoken words and/or refreshable Braille.  JAWS is 
designed to work in a Windows environment. It is compatible with almost all Windows 
applications.  Commands that make JAWS speak fall into two categories:  

1. JAWS will speak all Windows keyboard commands and all MS Word keystrokes 
and commands  

2. JAWS has its own command set for speaking text and to enable blind users to 
move to the parts of the screen and other information that is present visually, 
(e.g. Window title).  This allows the Braille user to use Windows without using a 
mouse.  JAWS also has its own command set to customize the speech itself (e.g. 
pitch, rate)  

JAWS has multiple cursors, however, the two that are introduced to beginners are the 
PC cursor, which provides speech for all keyboard commands, and the JAWS cursor 
which is similar to the mouse pointer in that it can travel all over the screen (using the 
Arrow keys) and speaks that location. If you wish to experiment you can switch between 
the two by pressing the Numpad + key for the PC cursor and the Numpad + - key for the 
JAWS cursor)  

Some important Program commands that are specific to JAWS include:  

• Interrupt Speech -- Control key  
• Say Window Title -- Insert + t  
• Say Top Line of Window -- Insert + end key  
• Say Bottom Line of Window -- Insert + Page Down  
• Screen Sensitive Help -- Insert + F1  
 
Some important Dialogue Box commands that are specific to JAWS include:  

• Say Default Button -- Insert + e  
• Read Box in Tab Order -- Insert + b  
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JAWS has many helpful features. Some of these include:  

• Various levels of verbosity (detail) which give varying degrees of description of a 
window, control or field, can be adjusted depending on the user’s needs (defaults to 
verbosity: most)  

• A virtual viewer which gives explanations in a separate window that can be read and 
reviewed by line.  

• In a word processor all text attributes will be described by pressing Insert + f  
• Note that within the JAWS program you do have access to context sensitive JAWS 

Help where you will find an extensive list of commands Insert + F1  
• There is extensive on line documentation for the instructor within JAWS. Go to the 

JAWS Menu; select Help; then JAWS Help Topics; then go to the Contents page and 
read New Users Start Here and Keystrokes.  It is reasonable to expect the student to 
start looking for answers themselves within this help documentation. 

4. E-text 

Introduction 

Students who are blind require access to alternate format, digital, electronic text 
materials accessible through speech, refreshable Braille and/or magnification. E-text, or 
electronic text, is a computer readable electronic file that duplicates a physical, print text 
such as a textbook. E-text is strictly text. There are many types of etext including ASCII 
or Text (.txt), Rich Text Format (.rtf), Word Perfect (.wpd) and Word (.doc). Most of the 
e-text produced for PRCVI comes in ASCII, Word Perfect and Word. Graphic information 
(pictures, charts and graphics) found in the print textbook should be made available to 
the student. PRCVI provides an accompanying tactile diagram booklet(s) for many titles. 
If another supplier provides e-text without tactile diagrams and if it is determined that 
these graphics are necessary for the students’ understanding, then they should be made 
available.  Students who are proficient with computer technology can create their own e-
text using a scanner and appropriate OCR software (e.g. Arkenstone Open Book or 
Kurzweil)  

Prerequisite to using e-text  

Student needs to have basic computer and word processing skills. They also require 
basic operating skills for their screen reader (e.g. JAWS) and/or their screen 
magnification program (e.g. Zoomtext Level 2 or Magic). Braille note takers (e.g. Braille 
‘n Speak, Braille Lite or Braille Note) may also be used to access e-text although they 
are beyond the scope of this presentation.  

Necessary Team Support  

• Positive attitude towards the use of e-text 
• Staff competency in using hardware and software 
• Basic troubleshooting skills 
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Classroom Implementation Strategies 

• Start young - share simple stories, for example, classmate stories can be made 
available on disk (remember to include descriptions of pictures and graphics and/or 
construct a supplementary tactile diagram booklet) 

• Read beginning "chapter" books in e-text 
• Provide a Braille or Large Print hard copy to complement the e-text when the student 

is learning to use e-text 
• Encourage the experienced user to choose the medium that best suits the specific 

task. 
• Keep the "original" safe. E-text should be saved on the student’s hard drive (C:\) in 

the subject folder 
• E-text is often provided in many individual files. It may be necessary to provide 

instruction on how to merge and append these files in order to build the book (see 
section Using E-text Textbook with MS Word 2000) 

• Provide instruction concerning format issues with respect to Table of Content, Page 
Number Location, and Graphic Descriptions 

• Teach the use the Find feature to locate page, keywords, and markers 
• Teach the use of Copy and Paste features to input information into a new document 

• Provide instruction concerning copyright issues 

User Profile Checklist 

In order to successfully use e-text the following skills are necessary:  

1. View and open files from a floppy disk. 

2. Navigate the Treeview and Listview in Windows Explorer. 

3. Create new folders in Windows Explorer. 

4. Rename files in Windows Explorer.  

5. Copy and paste documents within Windows Explorer.  

6. Understand extensions (.doc .txt .wpd .rtf).  

7. Open, read and save Word and/or Word Perfect documents.  

8. Open, read and save Notepad and WordPad documents.  

9. Copy and paste (multiple) e-text file(s) contiguously from the floppy disk into a 
single file (merge or append).  See section titled Using Insert File to assemble 
ebook.  

10. Use the Find Text command to navigate the textbook file.  

11. Move (within the application) between the textbook file and files made for notes 
and assignments.  

12. Move between application programs.  
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Information and Instructions on JAWS and E-Text 

Inserting a personal marker to save your place  

• Insert a marker to find your place easily the next time you open the file by typing in 
a code word (nonsense word e.g. lookingfor) at the spot where you would like to 
open the file next time. 

• Save file. (Ctrl S) 
• When you open the file the next time use the "find" command (Control+F) on the 

code word and the file will open at that place. Do not use common words as they 
will be found in other places in the file. 

• This can also be done with the Bookmark feature in Word however the bookmarks 
must be inserted prior to use. Inserting your own nonsense word seems quicker 
and reinforces the Find command which is a key to efficient reading of an ebook. 

Using an E-text Textbook with MS Word 2000 and JAWS  

Some of the e-text titles come in sections or in chapters.  Many students will be more 
efficient if they have a copy of the complete e-text book. There are 2 ways that you can 
assemble the files into an ebook. The first and preferred way is to use MS Word’s 
Insert File feature found in the Insert Menu.  The second and more time consuming 
way is to copy and paste the files into a new file until you have assembled the book. 

Using Insert File to assemble ebook 

• Put the E-text disk in A:Drive. 
• Go to Start Menu (Ctrl + Esc), select Programs (P), select Windows Explorer and 

press enter. 
• Select C:\ and open the File menu. Select "New" and choose "Folder". Name the 

folder according to the subject. 
• Make a new folder within the subject folder and name it "textbook". 
• In Windows Explorer select 3 1/2" Floppy (A:) by using up arrow and press enter. 

All the files on the A drive will be shown. Select all of the files on the disk (Ctrl + A). 
Copy them into the "textbook" folder. 

• Open a new document in Word. 
• Save new document as "file name_assembled" 
• Choose Insert File from the Insert Menu.  In the Insert File dialogue box select the 

first chapter file and then hit Enter. 
• Repeat Insert File until you have inserted each file in the book.  Make sure that 

each file is inserted in order and don’t move the cursor until you have assembled 
the complete ebook. Note that the cursor defaults to the end of the inserted file, if 
you move around in the file and then use Insert File that file will be inserted at the 
cursors prior location. 

• Save the document (which now contains the collated book) with the book title into 
the subject folder. 

• Delete the "textbook" folder that had all of the individual sections or chapters 
 
Note:  you may rename assembled book as you see fit. 
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5. JAWS and the Internet 

Introduction 

Why use the Internet?  
A great deal of useful information is available online to students who are blind.  This 
includes information that is not otherwise available in any other medium.  Examples of 
this information are:  

• Newspapers and magazines 
• E-text books 
• Source documents and reference material needed for reports and assignments.  

JAWS makes the Internet quite accessible (however, it has some of its own key 
commands to do so). Once a web page is loaded JAWS automatically describes the 
page re: the existence of frames and the number of links. The virtual cursor then takes 
over and reads the entire page identifying links, edit field, radio buttons, etc. JAWS also 
informs the user when frames are being entered and exited. The speech can be halted 
at any time and the user can direct JAWS to read by line using the arrow keys. The user 
can move from one link to the next by link by pressing the Tab key.  If there is one or 
more edit fields on the page JAWS has the ability to go into Forms Mode and move 
between them. A complete web page can also be copied and pasted into a Word 
document if the user so desires. Students should be encouraged to use the Internet. It 
will be desirable to direct students to sites that are of interest to them starting with easily 
accessible sites. As the student becomes more proficient with the Internet and JAWS 
then they may be directed to more complicated web sites. 

Pre-requisite skills 

• Familiarity with basic computer operation 
• Familiarity with JAWS including multiple cursors and when to use them 
• Familiarity with Internet Explorer 5.5 
• Familiarity with a word processor 

Equipment Needed 

• Pentium computer with modem or network card installed and configured 
• JAWS current version 
• Microsoft Internet Explorer ver. 5.5 or 6.0 (Note JAWS is designed to work 

seamlessly with the Internet using Microsoft Internet Explorer ver. 5.5 or 6.0) 
• Access to the Internet through an Internet Service Provider (ISP) or network 

Internet Concepts 

• An understanding of the nature of web pages, which may include graphics, multiple 
panes (called frames), pop-ups in new browser windows, link(s), 

• The Uniform Resource Locator (URL) which is the specific web address and must be 
entered exactly in order to open the web page. 
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• In order to make Internet Explorer accessible there are some JAWS concepts and 
keystrokes that must be learned and understood. An example of this is the Virtual 
Cursor (available in the more recent versions of JAWS). 

Information and Instructions for JAWS and the Internet 

• Information is found on the Internet using "Search Engines". 
• The choice of search engines is important. Desirable features include: accessibility 

with JAWS or large print magnification program, few graphics; options to search "any 
word", "all words", or "as a phrase". 

• Several useful search engines are www.google and www.yahoo.ca; most students 
find Google quite accessible. 

• Meta-search engines search other search engines to find more sites relevant to the 
search query. 

• Stand alone programs such as Copernic (www.copernic.com) search many other 
search engines and provide a list of query results in the form of links. Choosing a link 
opens Internet Explorer and goes to that website. All search results are saved within 
the program for future reference.  If the JAWS scripts for Copernic are loaded then 
Copernic is very accessible to JAWS’s users.* 

• Relevant web material can be copied from Internet Explorer (Edit menu) into a word 
processor and saved for future reference. 

• Many people are concerned about the appropriateness of some of the information on 
the World Wide Web (Internet).  Using Grolier Encyclopedia and its protected 
Internet search capabilities is sometimes an acceptable way to access the 
information on the web while ensuring that the student is screened from 
inappropriate information. 

Advanced Internet Navigation with JAWS  

(Note the reading of these files is not required for this presentation however they are 
useful resources.)  
Explanations of JAWS commands related to Internet Explorer can be found within the 
JAWS Help files. To find these commands open: JAWS Help; then open the "Contents" 
page; open "Popular Applications with JAWS"; open Internet; open Internet Explorer; 
open JAWS Specific Keystrokes.  If additional detail is required open the "detailed 
description of keystrokes" link.  
It is beyond the scope of this presentation to describe advanced Internet navigation with 
JAWS.  Useful resources to support teachers and students may be found in the 
previously cited JAWS Help Files for Internet Explorer and the tutorials prepared by 
Kathleen Beaver at the following URL:  
 
http://atto.buffalo.edu/registered/Tutorials/jaws/index.php  

Also see Appendix C: JAWS and Internet Explorer 

 
Vision Technologies: Access to Literacy - ALT-VI 2003 

Page 77 



Section 4: Screen Readers 

6. Grolier CD-ROM Encyclopedia 

Description of Student needs 

Low-vision and blind students need an independent method of accessing resource 
material for research projects. With the availability of appropriate CD- ROM multi-media 
resources like the Grolier 1999 or 2000 Multimedia Encyclopedias, coupled with access 
to the Internet, computer-centered "information retrieval" promises to provide 
unencumbered access for these students.  
A large print user may use many different CD-ROM encyclopedias. The screen review or 
JAWS user is limited to Grolier 1999 or 2000 since these are the two versions that are 
accessible to JAWS currently.  

Prerequisite skills to use the encyclopedia independently 

• Good JAWS skills for navigation within Win ME/98/XP 
• Ability to switch between open applications (JAWS, Word & Grolier) 
• Effective word-processing with JAWS skills for navigating, selecting, copying and 

pasting 
• Familiarity with multiple pane pages. (Windows Explorer with its List and Tree views 

is an example of page with multiple panes.) 
• Understanding of multiple cursors and how/when to use them 
• If the student is going to use the Internet search features of Groliers, then some 

limited familiarity with JAWS access to the Internet 

Equipment Needed  

• Windows ME, 98 or XP based computer 
• Word-processing program, MS Word for Windows is the most accessible to JAWS 
• JAWS (current version) screen review software 
• Internet Explorer 5.5 or 6.0 
• Grolier 1999 or 2000 Multimedia CD-ROM Encyclopedias 
• If the student is going to use the Internet search features of Groliers then Internet 

access must be in place (LAN or Modem) 

Team support needed to ensure technology would be implemented successfully 

• Good JAWS skills with respect to complex (multi-media) screen presentations. 
• Introduce JAWS & Windows concepts 
• Set up Grolier’s before student tries to use software. Out of the box, it is not fully 

accessible to the JAWS user 
• If the student is going to use the Internet search features of Groliers then setup 

Internet Explorer as the web browser for Grolier 

Classroom implementation strategies 

• Show student how to access the extensive help documentation contained within 
JAWS. (Open JAWS; Open Help Topics; Open Contents Page; Open Popular 
Applications with JAWS book; Open Reference & Educational book; Open JAWS 
Specific Keystrokes. For an explanation of each keystroke & some related 
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information Open JAWS Specific Keystrokes and then Open link Detailed Description 
of Keystrokes.) 

• Practice - Find text and subsequent Copy from Grolier’s & Paste into Word using 
JAWS.  (If not already proficient) 

• Coach user in keeping "keyboard command sets" differentiated as they switch 
between programs. (JAWS vs Windows vs Groliers) 

• Access sound clips and recordings from within Groliers 
• Access Internet with protected access provided by Groliers 

Common barriers or challenges that might occur 

• Some features of Groliers are completely graphic (not text) and as such are not 
accessible to JAWS 
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Appendices 

Appendix A:  Windows Navigation 

Windows Cursor Navigation  

Windows uses standard keystrokes within a document for moving the cursor (regardless 
of the word processor used). Windows cursor navigation commands are:  

• To move the cursor by character use the Left and Right Arrow keys 
• To move by word use CONTROL + Left or Right Arrow keys 
• To read by line use the Up and Down Arrow keys 
• To move the cursor to the start of the line press the Home key 
• To move the cursor to the end of the line press the End key 
• To move the cursor to the start of the next paragraph press CONTROL + DOWN 

ARROW 
• To move the cursor to the start of the previous paragraph press CONTROL + UP 

ARROW 
• To move the cursor to the start of the document press CONTROL + Home 
• To move the cursor to the end of the document press CONTROL + End 
• To move the cursor to the start of the next or previous physical print page press 

CONTROL + Page Down or CONTROL + Page Up 

Windows Editing Commands 

The following commands will make changes to text that is written:  

Selecting Text 

Windows has standard keystrokes for selecting (highlighting) text. Text must be 
selected before it or its attributes (font, size, bold, italics etc) can be changed. Text 
that is selected (highlighted) is very fragile. It will be replaced by any letter that is 
typed and will disappear entirely if Enter or the Spacebar are pressed. If you make 
any mistake and your text disappears, you can Undo it by pressing CONTROL + Z. 
Each time you press CONTROL + Z the screen will display the text prior to that 
keystroke, so if a mistake is made but not realized for a few keystrokes, the user can 
go back to the mistaken keystroke by pressing successive CONTROL + Z 
commands.  
The Windows commands for selecting text are:  

• Select Letter  Shift + Right or Left Arrow 
• Select Word  Shift + CONTROL + Right or Left Arrow 
• Select Line  -  With cursor in home position press Shift + Down Arrow 
• Select Paragraph  With Cursor in home position press Shift + CONTROL + 

Down Arrow 
• Select All Text in the document  CONTROL + A 
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Editing Text 

Windows has standard editing commands (common to all word processors). They 
are:  

• CONTROL + Z - to undo the last text entered or command given. Repeated 
Undo commands allow the user to return to previously entered text. 

• CONTROL + Y - to redo the last text entered or command given. 
• CONTROL + X - to remove or cut selected text from the document and place it 

on the clipboard. The clipboard is a temporary holding area on the computer 
where text can be stored. 

• CONTROL + C - to copy selected text to the clipboard. 
• CONTROL + V - to paste text back into your document. Text that has been 

copied or cut to the clipboard will be pasted at the new cursor position regardless 
of the application that is open i.e. text cut or copied from Word can be pasted into 
another word processor or email document. 

Note that text must be selected before the above commands will work (except the 
Undo command)  

Changing Text Attributes 

Windows has standard attribute commands for changing the appearance of text. 
These commands are common to all word processors. They are:  

• CONTROL + B - to make selected text bold (pressed again will the remove bold 
style) 

• CONTROL + I - to make selected text in italics (pressed again will the remove 
italics style) 

• CONTROL + U - to make selected text underlined (pressed again will the 
remove the underline) 

• CONTROL + SPACEBAR - to remove all styles and make selected text plain 

Formatting Commands 

The following formatting commands will affect the whole line or paragraph that 
contains the cursor. There is no need to select text for the following line commands 
to work.  

• CONTROL + E - to center text 
• CONTROL + L - to left justify text 
• CONTROL + R - to right justify text 
• CONTROL + J - to block (right and left) justify text 

 

Dialogue Boxes 

A dialogue box is an interactive window that opens over top of your document to 
request information from you. It does not have a menu bar, but rather, has a series of 
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different types of buttons and controls. When faced with a dialogue box you must 
respond to it or Windows won’t let you proceed. If you want to close the dialogue box 
without choosing any options, press Escape. This will return the user to the text edit 
field.  

You will encounter dialogue boxes when you choose an item from a pull-down menu 
that ends in an ellipsis (...).  The most common ones are "print", "find", "save" (only 
the first time) and "save as".  
When a dialogue box opens it becomes the active window. This window presents 
you with options from which a choice must be made. To move through the options in 
a dialogue box press the TAB key.  

While there are many different dialogue boxes, they look similar. There are 8 
different Controls that provide for all possible options in any dialogue box. These 
Controls make changes and execute the commands in the dialogue box. Not all 
dialogue boxes will contain all of the 8 Controls. All dialogue boxes will have a 
default option (usually the OK Button). Windows will move the focus to the default 
option (e.g. OK) as soon as the dialogue box opens. A default is the option the 
computer thinks you are most likely to choose so it is already selected. If the 
dialogue box requires that you type in information before you continue, this will be 
the default option. This area where the computer is expecting you to enter text is 
called an edit field. The "Find" Dialogue Box is an example of this.  

The Controls 

The 8 Controls that allow you to choose options and execute commands in a 
Dialogue Box are: Button, Check Box, Radio Button, Edit Field, List Box, Combo 
Box, Slider and Spin Box. To move from Control to Control press the Tab key. Use 
Shift+Tab to go back to the previous Control.  
Within a dialogue box, each Control is different and has its own Windows command 
to manipulate it. 
 
Multi Page Dialogue Boxes (tabbed pages) 
Some Dialogue Boxes are divided into related pages where each page is a separate 
Dialogue Box (called Multi-Page Dialogue Boxes). Page Setup in the File menu is a 
good example of a Multi-Page Dialogue Box. Press CONTROL + TAB to switch 
between pages in a Multi Page Dialogue box in succession, regardless of where the 
focus is within the page. Pages cycle continuously as CONTROL + TAB is pressed. 
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Appendix B: MS Word 

There are many settings within Word that will make it much easier and more efficient for 
users who are blind. To keep Word as simple and efficient as possible, the following is 
recommended. Note that newer versions of JAWS may not require all of these changes 
to the configuration. The following 8 items are for your information. You do not have to 
try them as part of this Presentation.  However, you may find them useful especially for 
some students and for older copies of JAWS and MS Word.  

1. Turn off the Office Assistant. To do this, choose the Help icon from the Standard 
toolbar. Choose Options and uncheck everything. Close the Office Assistant. 
(Not required for JAWS 4.02) 

 
2. Set the screen view to normal. To do this open the View menu, select "Normal", 

and press Enter.  
 
3. Remove the ruler. To do this, open the View menu and select "Ruler". Uncheck it 

by pressing Enter.  
 
4. Remove all toolbars except the formatting toolbar. To do this, open the View 

menu. Go to the Toolbars submenu and uncheck all other toolbars using the 
Enter key.  

 
5. Remove all automatic formatting options for automatic numbers and bullets. To 

do this, open the Tools Menu and choose Auto Correct. A Multi-Page Dialogue 
Box opens. Use CONTROL+TAB to open the "AutoFormat as you type" page. 
Arrow through the page and uncheck "automatic bulleted lists" and "automatic 
numbered lists" using the Spacebar. Use CONTROL+TAB to open the 
"AutoFormat" page. Arrow through the page and uncheck "automatic bulleted 
lists". Tab to the OK button and press Enter to close the dialogue box. 

  
6. Remove automatic spelling and grammar indicators. To do this, open the Tools 

menu and then open Options. A Multi-Page Dialogue Box opens. Use 
CONTROL+TAB to open the "Spelling and Grammar" page. Arrow through the 
page and uncheck "check spelling as you type" and "check grammar as you 
type". Tab to the OK button and press Enter to close the dialogue box. (Not 
required for JAWS 4.02) 

 
7. Remove the vertical and horizontal scrollbars. To do this, open the Tools menu 

and then open Options. In the Multi-Page Dialogue Box that opens go to the 
View page by pressing CONTROL+TAB. Arrow through the page and uncheck 
"horizontal scroll bar" and "vertical scroll bar". Tab to the OK button and press 
ENTER to close the dialogue box.  

8. Set File Menu to display up to the 9 most recent documents. The default number 
is 3. To increase it open the Tools menu. Open the Options Multi-Page Dialogue 
box. Use CONTROL+TAB to open the "General" page and arrow to the "recently 
used file list". Press Tab and you will go to the Spin Box where you may type in a 
new number, up to 9. Tab to the OK button and press Enter to close the dialogue 
box. Word will now display that number of recently used documents at the end of 
the File menu. 
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Appendix C: JAWS & Internet Explorer 

• Press ALT + d to move the focus to the address bar and type www.google.com and 
press Enter. Listen to how the Virtual Cursor reads text, and identifies links and radio 
buttons. Note that you can read the address bar without moving the focus to it by 
pressing Insert + a.  

• Press Insert + F7 to see the JAWS Links dialogue box. Note the options that the user 
is presented with. Press Escape to exit this dialogue box.  

• Press Control + Insert + Home to move the JAWS focus to the search edit field.  
• Press Enter to turn on Forms Mode so that you can type in this edit field (Note that 

although the Windows focus is on the edit field on this web page, not all web pages 
default to the edit field so this is JAWS way of getting the focus on the edit field.  

 

A “Related Materials” section is included in this resource book.  Please refer to the 
Related Materials section for a list of narrated screen demonstrations that have been 
developed for each content section. All narrated screen demonstration files are included 
on your Accessing Literacy cd, also included with this resource book. 
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SECTION 5 
PRODUCTION OF E-TEXT (SUPPORTED)  

THROUGH SCANNING 
AND 

OPTICAL CHARACTER RECOGNITION 
(WHAT IT IS AND SUGGESTIONS FOR DOING IT BETTER) 

Introduction 

The module Production of E-text (Supported) Through Scanning and Optical Character 
Recognition will address the use of the OCR program OmniPage Pro12 and a scanner.  
It will outline the scanning procedure and provide tips and strategies for efficient and 
successful implementation. 

Description of Student Need 

Students need to access all of the print resources that are used in the classroom, both 
textbooks and Teacher prepared materials. They will do so in a variety formats including 
e-text which can be made available to the student in hard copy Braille and refreshable 
Braille. 

Assumptions 

Materials provided in hard copy will require that the student has an organized   way of 
filing and retrieving paper Braille.  Materials provided in e-text will require that the 
student can independently use (or is actively learning) the technology that receives and 
stores it. The student will benefit from the active process of reading, (rather than the 
passive process of listening), therefore the student who utilizes scanned text should, 
whenever possible, do so via hard copy (translated) Braille or a refreshable Braille 
display.  Due to its graphical interface, OmniPage Pro 12 is not fully accessible to a blind 
user. Products by Arkenstone and Kurzweil are better suited to providing independent 
access to print, for blind users. 

Prerequisites 

The person providing the material (the Braillist) will have a good working   knowledge of 
the OCR program, a word processor, and the operating system of the computer. The 
person receiving the material will have a good working knowledge of their device 
(computer or notetaker) for file storage, organization and back up). 
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Classroom Implementation Strategies 

• The student will require storage space in each classroom if hard copy Braille is being 
provided. 

• For e-text letter baskets can be placed in classrooms so print materials can be left by 
the teacher and e-text (on disk) can be left for the student. 

Common Barriers or challenges that might occur 

• Not receiving materials with sufficient time to produce it in e-text. This can be 
minimized if Braillists are in daily communication with the classroom teachers. 

• The complexity of the technology (both the computer operating system and the 
software that is used.  This can be minimized by networking with others who use the 
same technology. It can also be minimized through relevant in-servicing and the 
ability of the person using the technology to become an independent learner (by 
using the Help files). 

• The student may require ongoing instruction on the use of their technology and their 
ability to organize the materials that they receive. 

Equipment Needed 

• Current Pentium computer (512 meg RAM, Windows XP) 
• Industry standard optical character recognition (OCR) software (e.g. OmniPage Pro 

12) 
• Supported scanner (e.g. Epson). Check scanner speed before purchasing 
• Industry standard word processor (e.g. Microsoft Word 2000 or 2002 
• (Optional) Braille Embosser 
• (Optional) Automatic Document Feeder  is a useful add-on for high volume e-text 

production 

FAQ 

1. Why is it necessary for students to have all of this in e-text, when someone could just 
read it to them? 

Students who are blind have a right to the same learning opportunities as their 
sighted peers. This includes access to written materials in a format that provides 
spelling, punctuation and the ability to retrieve it at their convenience. 

2. Is it necessary to make the e-text look exactly like the print page? 

No.  Things like running headers and footers, with the exception of page numbers, 
are unnecessary as they add to the student’s reading load. Students are reading for 
information and repeated text simply slows them down. Students generally prefer 
headings to be left justified as it saves them from searching across their Braille 
display (or across a hard copy page) for text. 
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3. Is it OK for the student to use my office as a home base? 

No. Students who are blind spend a disproportionate amount of time with adults.  
Our job is to support them in the background and foster their independence. 

Information and Instructions OmniPage Pro 12 

Part A.  Preliminary Information 

• OmniPage Pro 12 was designed primarily as a business application. This module 
only elaborates on features of the program related to the production of e-text for 
students who are blind or low vision. 

• Certain features of the program are beyond the scope of this document. These 
features include: 

o Creating and using Abobe PDF 
o Creating zone templates 
o Proofing OCR results 
o Verifying text 
o User dictionaries 
o Training OCR 
o Reading text aloud 

• This document may be best utilized by having it running in the background. You can 
then access it at any time from the Windows Taskbar located at the bottom of the 
screen (make sure Auto Hide in the Taskbar properties menu is unchecked). 

Why Scan? 

• Students have access to any and all reading material, thereby encouraging them to 
read more. 

• Material can be provided for blind and low vision students quickly and on-sight, thus 
providing them with written information at the same time as their classmates. 

• The resulting e-text is not consumable, takes up no external space, can be easily 
and efficiently organized, and is permanently archived for future students’ reading 
needs. 

• Students equipped with a computer or Braille notetaker and a refreshable Braille 
display can carry disks rather than cumbersome multi-volume Braille books. 

• By using the “Find” command in their word processor students can navigate  e-text 
easier and faster than hard copy Braille. 

Some Considerations 

• Transferring files to your student is much easier if you and the student have the 
same operating system. In most cases this will mean that a Windows operating 
system is preferable. 

• Newer versions of OCR and word processing programs are large. The faster the 
computer and the more RAM it contains will largely determine the speed at which the 
process can take place. 
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• Scanners vary greatly in the speed that they pass over the document. This is 
determined by the connection of the scanner to the computer (USB or parallel); the 
dots per inch (dpi)settings within the scanner software and whether the optical 
character recognition (OCR) is set to scan colour (slower) or black & white or 
grayscale (faster). 

• Setting the scanner’s own software (see scanner manual) to 300 x 300 dots per inch 
(dpi) will increase scanning speed and optimize the results for text. (Note: This is not 
the optimum dpi setting for colour photographs or pictures). 

About the Source Document (Paper) 

• OmniPage Pro 12 attempts to reproduce the letters and words on the page to match 
the original. Many factors can cause OmniPage Pro 12 to make mistakes which 
result in the need to manually correct the spellings of words. See “About the Clean 
Up”. 

• The better the quality of the source document, the less time will be spent doing clean 
up. 

• Examine the text on the page to determine if there are parts that do not need to be 
scanned (e.g. running headers, footers). One quick way to eliminate these from the 
resulting document is to cover them with post-it notes before scanning the page. 

• For close columns you can draw a pencil line between them.  This eliminates the 
scanner joining two columns into one zone and creating lines of text that run across 
both columns. This applies mainly to older OCR programs. 

• Books opened with two facing pages can be scanned at once (e.g. novels) and 
OmniPage Pro 12 will correctly order the two pages. Make sure that “Look for facing 
pages” is checked (Tools / Options / Process). 

• It is unlawful under current copyright laws to reproduce print copies of books for 
students unless the original print copy has been purchased or permission has been 
received from the publisher. 

Part B. The OmniPage Pro 12 Program 

General Information 

• Consistent with all Windows programs, any menu item ending with an ellipsis (…) will 
result in a dialogue box being opened when it is chosen. 

• When you hover your mouse cursor over any box, button or icon in the program, a 
description of its function will be displayed in the Status bar at the bottom of the 
OmniPage Pro 12 desktop screen. 

• Right clicking on any control in a dialogue box will present a tool tip screen that 
explains the options for that control. 

• Help may be obtained three ways from the Help menu:  

1. An online manual broken into chapters 
2. A searchable index that displays all topics in the online manual 
3. A searchable index that displays only topics related to the search item 

• Help may obtained at any time by pressing F1. This help is context sensitive and will 
relate to the specific aspect of the program that you are currently working with. 
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The OmniPage Pro 12 Desktop 

• The OmniPage Pro 12 Desktop has a Title Bar and a Menu Bar along the top. 
• Below that is a Standard toolbar for common tasks (print, save etc). 
• Below the Standard toolbar is the OmniPage Pro 12 Toolbox consisting of 2 rows of 

buttons. The first row contains: the Start (1 2 3) button; the Get Page (1) button; the 
Perform OCR (2) button; and the Export Results (3) button. Below each button is a 
drop-down list where settings for each button are made. 

• The OmniPage Pro 12 Desktop has three main working areas, separated by splitters 
for resizing the pane. They are the Image Panel, the Text Editor, and the Document 
Manager. 

• Along the bottom of the OmniPage Pro 12 Desktop there is a Status Bar where the 
appearance of the Desktop can be changed by hiding or showing the Image Panel, 
the Text Editor and the Document Manager. 

The Image Panel 

• The Image Panel, on the left, is divided into two sections, separated by a (vertical) 
Image toolbar.  

• The Image Panel displays a thumbnail image of each page on the left side of the 
Image toolbar and the zones for the selected (thumbnail) page on the right side. 

• After a second page has been scanned, you must click on each thumbnail to view 
the recognized text for it. The current page is indicated with an “eye icon”. You can 
re-order pages by dragging a thumbnail and placing it between other thumbnails.  

• Various icons will appear in the thumbnail to indicate its status (see manual p.26 for 
details on icons). The most important ones are: the “glasses” icon indicating that the 
page has been recognized, and the “disk” icon indicating that the page has been 
saved. 

• The Image toolbar in the middle is used to manually re-order, delete or re-draw the 
zones for the selected thumbnail page (see The Image Toolbar). 

The Text Editor 

• The Text Editor, on the right, displays the recognized text for the thumbnail that is 
selected.  

• The Text Editor has a formatting toolbar at the top to change the attributes of the 
recognized text. To do this you must select the text first. Also on the formatting 
toolbar are buttons to: 

1. Add/remove bullets from selected text in the Text Editor 
2. Show/hide non-printing characters in the Text Editor 
3. Show/hide the Verifier (see owners manual for information) 
4. Find the next suspect (non-dictionary word) 
5. Show/hide the reading order of paragraphs, tables, graphics (see Changing 

the Reading Order) 
6. Change the reading order of paragraphs, tables, graphics (see Changing the 

Reading Order) 

• If the formatting toolbar is not visible select it (View menu / Toolbars / Formatting).  If 
only part of the formatting toolbar is visible (i.e. Reading Order buttons not showing) 
re-size the Text Editor pane by putting your cursor on the splitter line separating the 
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Text Editor and Image panel, click and drag to the left to make the Text Editor pane 
larger. 

• The Text Editor has view buttons at the bottom to change the way recognized 
appears for editing. The choices for viewing recognized text are:  

1. True Page (exact replication of the original page)  
2. Retain Font and Paragraphs (text retains attributes but is decolumnized) 
3. No Formatting (text is decolumnized and stripped of all attributes and format) 

 

• The view buttons are only for viewing while editing and are independent of the way 
text will be exported to a file (e.g. viewing text in “No Formatting” does not mean it 
will be saved without formatting – see The Save Dialogue Box to change the way 
text is saved). 

The Document Manager 

• The Document Manager, located below the Image Panel and Text Editor provides 
details of your document in a table format.  

• Each row represents one page and the columns give statistical or status information 
for the page.  

• If it is not necessary to see the Document Manager it can be removed from the 
desktop view by clicking the corresponding button on the Status bar at the bottom of 
the OmniPage Pro 12 desktop. 

The Process (The Big Picture) 

• OmniPage Pro 12 turns paper documents into electronic documents containing 
editable text (e-text) through the use of a scanner. 

• OmniPage Pro 12 turns non-editable text, such as Abobe PDF files (.pdf) into 
electronic documents containing editable text (e-text), 

• It is done in 3 steps: capturing the page as a graphic; ordering the information on the 
page into zones (both pictures and text); and converting the words from a graphic 
into editable text (recognizing it). 

• Once editable text has been created, it can be saved (in many common file formats) 
and given to the student (on disk or via email) or it can be saved and opened in a 
Braille translation program for the creation of hard copy Braille. 

• The entire process outlined above can be done from within a word processor without 
opening OmniPage Pro 12, as OmniPage Pro 12 can run in the background. See 
Scanning directly into Microsoft Word. 

• Pictures may be removed when the document is saved to a word processor (for 
Braille using students). To remove graphics when saving in OmniPage Pro 12 go to 
“Converter Options” in the Save As dialogue box and uncheck “retain graphics”. 

• It is possible to defer zoning and recognition and have it done at a later time . This 
frees the Braillist from waiting for these processes to be completed before scanning 
the next page. To do this press the Get Page button for each new page to scan it. 
When all pages have been scanned press the Export Results button. OmniPage Pro 
12 will ask you if you would like to have all pages recognized. Answer “yes’ and it will 
finish the zoning and recognition processes for all scanned pages. (This feature is 
unnecessary with fast computers as zoning and recognition happens before a new 
page can be placed on the scanner). 
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The Process (The Details) 

Using the OCR Wizard 

• This is the simplest way to use OmniPage Pro 12 as it guides you through the 
various settings and commands in 5 steps, by asking you questions. When you are 
done the 5 steps OmniPage Pro 12 launches “Automatic Processing”. 

• The OCR Wizard is a good way for new users to learn about the various settings and 
commands, however, it is not usually the method of choice once the user becomes 
familiar with the program. 

Automatic Processing 

• This is most appropriate for large jobs where pages are relatively simple (i.e. do not 
contain lots of sidebars and/or graphics with captions).  

• First, choose the appropriate setting in the Select Image Source listbox located 
below the Get Page button. See the section: Choosing from the Image Source listbox 

• Second, choose the appropriate setting from the Select Layout listbox located below 
the Perform OCR button. See the section: “Choosing from the Layout Description” 
listbox. 

• Third, choose the appropriate setting in the Select Destination listbox located below 
the Export Results button. See the section: “Choosing from the Select Destination” 
listbox. 

• Click the Start (1 2 3) button to have OmniPage Pro 12 automatically perform all 
processes according to the individual settings that you have made. 

• Scans can be scheduled to occur automatically. This allows you to turn the page and 
have OmniPage Pro 12 scan the next one after a set time (Tools menu/Options 
/Scanner tab).  Using this feature eliminates the need to press the Start (1 2 3) 
button to begin the scanning process for each page.  

Choosing from the Select Image Source listbox 

• Choose Load Image File if you do not want to use a scanner, but rather, have an 
image file (i.e. non-editable text such as a PDF fie) located on your computer  that 
you want to process (turn into editable text). 

• Choose Scan B&W for crisp black text on white paper. It works best with original 
source documents (not photocopies). If it yields acceptable results, it is the fastest 
way to process the document. 

• Choose Scan Grayscale for most situations. It typically provides the best results for 
both original black and white documents and those that have been photocopied. 

• Choose Scan Color if you have a colour document. This will significantly slow down 
the scanning process and create much larger files. It is not recommended to choose 
Scan Colour unless you are supporting low vision students for whom colour is 
important. 
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Choosing from the Layout Description listbox 

• This listbox tells OmniPage Pro 12 what to look for when it is creating zones. Zones 
are the separate areas on the page (text, graphics, tables). By dividing a page into 
zones, OmniPage Pro 12 knows how to reconstruct it during the recognition process. 

• The latest version of OmniPage Pro 12 is much more sensitive to tables. Many 
options in this listbox now relate to the inclusion of tables on the page. This setting is 
useful in that once exported to Word, Duxbury will recognize the table and translate it 
appropriately into hard copy Braille. 

• It is important to check this setting before starting a new scanning job. If it was set to 
single column and the new document has multiple columns, the resulting single zone 
text will join lines of text from both columns into one string. 

• Choose “Automatic” if the document does not have a consistent layout (some pages 
are single column and some have multiple columns) or if it contains both columns 
and tables. 

• Choose “Single Column, No Table” for simple layouts that do not contain columns or 
tables.  

• Choose Multiple Columns, No Table for most scanning tasks. Multiple columns can 
be decolumnized which is most appropriate for reading with a screen review program 
or for conversion into hard copy Braille.  Single column documents will not be 
affected by this setting (unlike the Single Column” setting which does affect multiple 
column documents). 

• Choose “Spreadsheet” for export to a spreadsheet program. 
• Choose “Custom” to pre-determine whether columns, graphics or tables will be 

detected. Make these settings in the Options dialogue box / Custom Layout section. 
This dialogue box is useful if you want to certain aspects (columns, graphics, or 
tables) detected, or not detected during the entire scanning job.  

• Choose “Template” to create a consistent zone pattern for every page in the 
scanning job. This can be useful if you want to eliminate running headers and/ or 
footers that have a consistent location on every page. 

• Do not confuse the zones that are created in this step with the output formatting level 
that will be chosen when you save. The choices made in this listbox simply tell 
OmniPage Pro 12 what to look for on the page during scanning.  

Choosing from the Select Destination listbox 

• Documents can be saved either as “images” (i.e. a picture of the word, therefore not 
editable) or as “recognized” (editable text). For most situations relating to student 
support scanned documents will be recognized before they are saved. 

• Choose “Save As File” to have the document saved after it is recognized. If you have 
multiple pages to scan and do not want the Save As dialogue box to open 
immediately after each page is recognized, check “Automatically prompt for more 
pages” (Tools / Options / Process dialogue box). OmniPage Pro 12 will display an 
“Add more pages” dialogue box for about 10 seconds before opening the Save As 
dialogue box. If you can put the next page on the scanner within this time period and 
press the “Add more pages” button, the next scan will start. Otherwise the Save As 
dialogue box will open. If you do not want to save yet, close the dialogue box and the 
“Add more pages” dialogue box will appear.  Continue scanning until all pages are 
scanned.   When you are finished scanning and the Save As dialogue box opens on 
the last page, name the file and open the Page Range listbox.  Choose “All pages” 
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from this listbox.  The File Options listbox now becomes active. Choose “Create one 
page for all files”. Now all scanned pages will be saved in a single file (see “The 
Save As” dialogue box).  

• Choose “Send as Mail” to have your default email program opened automatically and 
the file included as an attachment. A dialogue box will open asking the format of the 
attachment. 

• Choose “Save to Clipboard” to have pages saved to the clipboard, rather than have 
the Save As dialogue box open after each page is scanned.  Once all pages are 
scanned change the listbox to “Save as File” and click the button above it. The Save 
as dialogue box will now open. 

Manual Processing 

• Manual processing involves pressing the Get Page, Perform OCR and Export 
Results buttons on the OmniPage Pro 12 toolbox individually.  During manual 
processing only the action related to the button will be performed until the next button 
is pushed. 

• Manual processing is primarily used when you know that you will want to manually 
draw a zone (or zones), for recognition, from within the scanned page and leave the 
rest of the page unrecognized. 

• Using the Image toolbar you can re-draw zones, select zones for processing, ignore 
zones and have zoning changes immediately made on the recognized page (see 
The Image toolbar). 

• It is generally unnecessary to use manual processing as zones can be removed, re-
drawn or rearranged during the automatic process. 

• Any changes made to the zones on the page will be automatically made on the 
recognized page when “zoning on the fly” is enabled on the Image toolbar (see The 
Image toolbar). Otherwise the changes will be made when the Perform OCR button 
is pushed. 

About Zones 

• In order to reconstruct the page after it has been scanned, the program must 
organize it into its component parts and sequence them as per the original 
document. These parts may be headings, paragraphs, pictures, captions, sidebars or 
tables. Each part is enclosed in a border and becomes a separate zone. Only 
information in “process” zones will be recognized and transferred when saved and 
exported.  

• Zones can be set to “process” or “ignore”. Unless they are manually drawn using the 
“ignore zone” drawing tools on the Image toolbar, all foreground zones will 
processed (recognized) 

• The background is also a zone which can be set to “process” or “ignore”.  It is set to 
“ignore” by default 

• Zones are automatically determined by the program (when Automatic processing is 
activated by using the Start 1 2 3 button), but zones can be altered using the drawing 
tools on the “Image Toolbar” (located in the Image View).  

• Zones can be re-ordered so that the reading order will be changed in the final 
document. See “changing the Reading Order” 

• When you are manually processing you must manually draw the zones to be 
recognized 
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• There are 7 zone types. They are: Text zone; table zone; graphic zone; process 
zone; process background; ignore zone; ignore background. The zone types are 
determined automatically when automatic processing is used. When manually 
processing is used they are determined by the drawing tools on the Image toolbar 
that you used to created them 

• Zones may be ignored and therefore not recognized during processing. To ignore a 
zone select it by right clicking on the zone and choosing “clear” from the context 
menu that appears. This is an easy way to eliminate running headers and footers 
that may not be appropriate for e-text for Braille using students. Once a zone has 
been cleared you must press the Perform OCR button to have the changes 
displayed in the Text Editor if the “zoning on the fly” button is not pressed (see The 
Image Toolbar for information on this button). 

The Image Toolbar 

• This toolbar contains drawing tools which allow you to have complete control over all 
aspects of the zones on the page.  

• If zones need to be moved or re-sized it is usually better to do it when using the 
manual process. Moving or re-sizing zones that have been made during Automatic 
processing can create confusing results in the Text Editor. The Undo button on the 
standard toolbar can be used to return zones to their original state. 

• Hover your mouse over each drawing tool to get a description of it on the status bar. 
• The 5 drawing tools on the Image Toolbar are: 

1. Process zone: Use this tool to draw an area where you want auto-zoning to 
occur. The program will automatically determine what kind of zone it is (and 
break it into separate zones if necessary) 

2. Ignore zone (gray colour): Use this to draw a zone that you do not want 
transferred to the text editor, and do not want to be recognized for export to a 
word processor 

3. Text zone (brown border): Use this to draw a text zone. It will decolumnize 
text in the Text Editor and in the exported document 

4. Table zone: Use this to have the zone contents treated as a table. Table grids 
will be automatically detected or can be placed manually in the zone.  The 
manual creation of tables is beyond the scope of this document – see 
documentation that came with the program for information on this 

5. Graphic zone: Use this to draw an area that will be transferred to the Text 
Editor as an embedded graphic. That means it will not be recognized as text 

• There is a button on the Image toolbar to have the background set as a process 
zone (so it will be recognized in the Text Editor and exported). 

• There is a button on the Image toolbar to ignore the background. This is selected as 
the default. 

• There is a button on the Image toolbar to select a zone. Once selected the zone can 
be moved or the size of the zone can be changed. If you wish to change the reading 
order of the text, it is best done using the Reading Order buttons on the Text Editor 
toolbar (see Changing the Reading Order). 

• There is a button on the Image toolbar to rotate the zone. If you rotate a zone it’s 
properties and border will disappear i.e. it will no longer be a defined zone. 
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• There are two zoom buttons on the Image toolbar. One to zoom in on the text shown 
in the Image pane and one to zoom out. Note: once you zoom in you can’t zoom all 
the way back to the original size. 

• There is a button to have zone changes processed “on the fly”. When it is pressed 
zone changes are made immediately in the Text Editor. During manual zoning 
pressing this button will cause the page to be recognized without pressing the 
Perform OCR button. 

• There is a button on the Image toolbar to have zoning changes stored. Press the 
“Zone on the fly” button when you want to have them processed. 

Changing the Reading Order 

• Unlike previous versions of OmniPage Pro 12, the reading order is now changed 
from within the Text Editor (rather than by rearranging zones in the Image Panel) 

• To change the reading order: 
1. Choose True Page from the buttons at the bottom of the Text Editor. 
2. Make sure the Reading Order and Change Reading Order buttons are visible 

on the Text Editor toolbar (if not resize the pane as described in the Text 
Editor). 

3. Press the Reading Order button. Notice how gray arrows appear in the Text 
Editor showing the flow of text, tables and graphics (i.e. the reading order). 
This step is optional. Its only purpose is to map the flow of text. It stays in 
effect for all pages (until pressed again to toggle it off). It is not necessary to 
press it before pressing the Change Reading Order button. 

4. Press the Change Reading Order button. Notice how numbered (blue) boxes 
outline the different sections on the page. Click the “Define New Reading 
Order” button (blue down-facing arrow). Notice how all of the numbers 
disappear. Click on the boxes in the order that you want them to be read. The 
boxes will be numbered accordingly. To cancel the Reading Order changes 
click on the red X button. To restore the previous reading order, click the blue 
undo button. 

5. When the correct reading order is established click the green checkmark 
button. The new reading order will not show up in the True Page view (even 
though it must be set to this view to make the changes). To actually re-
arrange the text in the Text Editor you must switch to either the “No 
Formatting” or the “Retain Font and Paragraph” view.   

6. The new reading order will be exported to a word processor only if you 
choose “No Formatting” or “Retain Font and Paragraph” when you save. 
Saving with the Formatting Level set to “True Page” will not cause the 
reading order to be changed. 

The Dialogue Boxes 

Note: Only dialogue boxes that relate to the production of e-text or hard copy Braille will 
be discussed.  
Note: A tool tip description of any dialogue box item can be displayed by right clicking on 
it. 
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The Save As dialogue box 

• Only the features unique to OmniPage Pro 12 will be explained. 
• Open the “Files of Type” listbox to choose a file type. There are many file types that 

the document can be saved as. Some refer to specific destination programs (e.g. 
Word, Word Perfect), and others refer to more generic types of files (text, Unicode). 
For e-text choose the file type according to the destination program that the student 
will be using. For hard copy Braille choose Word as Duxbury will allow direct 
importing from Word (and will also preserve the formatting and style types). For use 
with a Braille notetaker, determine what file types are supported by the notetaker 
(Pacmates and Braillenotes will support Word, Braille Lites will only support text 
files). 

• Open the “Formatting Level” listbox to select how you want the final document to be 
exported (i.e. how it will look in the destination program that will open it after 
scanning is finished). The choices are: 

o No Formatting, which means exported text will be decolumnized and all unique 
attributes (bold, italics etc) will be removed. 

o Retain Font and Paragraph, which means text will be decolumnized but different 
and paragraph styles will be preserved in the exported document. This is typically 
the choice used for both e-text and hard copy Braille.  

o Flowing Page which means all aspects of the text on the original page (i.e. 
columns) will be exported to the target program. 

o True Page which means all aspects of the original page (including text, columns 
and tables) will be exported to the target program.  

o For most situations involving visually impaired students (blind and low vision) 
either No Formatting or Retain Fonts and Formatting will be used. Note that if 
pages have been reordered, the new reading order will not be saved if True Page 
is used. 

• Open “Converter Options” dialogue box (press Advanced button if it is not showing) 
to select or deselect various aspects of the document depending on how you want it 
to look in the destination program. These settings can be saved. This is useful if 
there are things you always want to remove from the final document (e.g. graphics, 
drop caps). 

• Check Save and Launch if you want OmniPage Pro 12 to automatically run the 
destination program (determined by the Files of Type listbox).  Typically you would 
keep this unchecked until the last page has been scanned. 

• The Page Range and File Options listboxes become active only after a second page 
has been scanned. In order to save many pages as a single file choose “all pages” 
and “create one file for all pages” respectively (see  Choosing from the Select 
Destination listbox). 

• Note how thumbnails in the Image Panel have a disk icon beside them when they 
have been saved. 
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The Options dialogue box 

• This is a multi-page dialogue box found in the Tools menu. Only the choices on each 
page that relate to the efficient production of e-text and hard copy Braille will be 
described. 

OCR page 

• Check the language of the source document. If the Braille translation program and/or 
the Braille notetaker supports foreign languages, the correct Braille contractions will 
be produced directly from the source document. 

Scanner page 

• Brightness and contrast can be adjusted here, depending on the quality of the source 
document and the resulting accuracy of the scan. If the characters in the source 
document are thick and touching, lighten the brightness and/or reduce the contrast. If 
the characters are thin and broken darken the brightness and/or increase the 
contrast. For large scanning jobs it is worth investing the time to get optimal accuracy 
from these settings. The payoff will be the reduced amount of cleanup necessary. 

• If you are using an Automatic Document Feeder check this box to enable double 
sided scanning. 

• If you are using a flatbed scanner you can have scans done automatically and set 
the time between scans here. This saves clicking the Scan 1 2 3 button to initiate 
each scan. 

Direct OCR page 

• Check “Enable Direct OCR” to be able to scan directly from, and into, your word 
processor (See Scanning directly into Microsoft Word). This may be preferable and 
more efficient than scanning in OmniPage Pro 12 and exporting the file to your word 
processor. OmniPage Pro 12 looks for common word processors and registers them 
within its program allowing you to enable Direct OCR. 

• Check “Draw Zones Automatically” to have text recognized in your word processor. If 
it is unchecked then text will remain as a graphic (uneditable text). 

• Check “Proofread OCR” to have the OmniPage Pro 12 proofreading window opened 
in your word processor. This is usually unnecessary as the word processor will have 
its own spellchecker. 

Process page 

• Settings here depend on the individual job that is being done. Each checkbox is a 
step or process OmniPage Pro 12 will have to take before it initiates a scan. Check 
only the boxes that are needed for the job as unnecessarily checked boxes will slow 
down the scanning process. 

• Check “Automatically prompt for more pages” to delay the opening of the Save As 
dialogue box while you place the next page on the scanner and click “Add more 
pages”. 
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• If the source document is a single page and will be carefully oriented with the top of 
the page at the top of the scanner, check “Automatically correct page orientation” in 
the “Process Settings” dialogue box (Tools / Options / Process). Doing this will speed 
up the scanning process. However, if the page is to be put in the scanner sideways 
or upside down make sure “Automatically correct page orientation” is checked.  

Proofing page 

• Check “Automatically Proofread Results after OCR” if you want to do the clean up in 
OmniPage Pro 12. It is not necessary to do the clean up here as your word 
processor will have its own spellchecker. 

Custom Layout page 

• Using radio buttons on this page you can customize the text and objects that 
OmniPage Pro 12 will look for when it scans a page or pages. Graphics can be 
eliminated from the scan here. This will speed up the scanning process and reduce 
cleanup. 

Typical Settings 

• These settings assume that you are producing e-text for a Braille using student (clear 
text, right side up orientation, no zone modifications, and recognition to be done at 
the time of scan). They are: 

1. Retain Graphics – unchecked  
2. Image Source – Grayscale 
3. Layout – Multiple Columns, no table 
4. Save dialogue box – Retain Font and Paragraphs 
5. Direct OCR dialogue box; Enable Direct OCR  – checked 
6. Direct OCR dialogue box; Draw zones automatically – checked 
7. Direct OCR dialogue box; Proofread OCR - unchecked 
8. Automatically Proofread Results After OCR – unchecked 
9. Process dialogue box; Automatically correct page orientation – unchecked 
10. Process dialogue box; Automatically Prompt for more pages – checked 

About the Clean Up 

• Cleanup involves the correction of spelling and formatting errors that OmniPage Pro 
12 has made. 

• Clean up may be done in either OmniPage Pro 12 or your word processor. 
• If clean up is done in OmniPage Pro 12 check the “automatically proofread results 

after OCR” checkbox located in the Tools / Options / Process dialogue box. After the 
OCR process you will be prompted to correct the suspect words on each page.   

• It is usually quicker correct the spelling and formatting of the entire document in the 
word processor (e.g. Microsoft Word), than to do it one page at a time in OmniPage 
Pro 12. This is because you can use the Find and Replace feature in the word 
processor to make global corrections to the document. Word will mark misspelled 
words with a red underline if  “Check Spelling as You Type” is activated (Tools / 
Options / Spelling and Grammar). This makes them easy to spot.  Uncheck 
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“proofread OCR” in OmniPage Pro 12 (Tools / Options / Direct OCR) if you are going 
to clean up in Word. It is redundant to have both the OmniPage Pro 12 and Word 
spellcheckers running at the same time and doing so may lead to system crashes.  

File Management 

• Make subject folders in Windows Explorer on your computer and have the student do 
the same. Avoid putting all finished files in “My Documents”. You can make subject 
folders within My Documents however, this is just another folder that must be opened 
to get to the subject folder. It is more efficient if subject folders (on both your 
computer and the student’s) are made directly off of the C:\ drive. 

• Teaching students some DOS basics can speed up their ability to open and save 
files (i.e. to open a file from disk type A:\  in the “Look In” listbox of the Open dialogue 
box; to save a file to a subject folder type C:\folder name\file name and it will be 
saved directly in that folder. 

• For students with their own laptops save the cleaned up document to disk (“Save 
As”) after saving it to your hard drive so that you always have a master document. 

PART C:  Scanning Directly into Microsoft Word (’98, 2000, XP)  

General Information 

• The OCR process can be done directly from within Microsoft Word, making it fully 
accessible for blind students to do their own scanning (however programs by 
Kurzweil and Arkenstone are designed specifically for independent access to print 
and have more features). 

• The process may be slower using Word because you must wait for the entire 
process before proceeding to the next page. This will depend on the speed of your 
computer. 

•  “Enable Direct OCR” must be selected in OmniPage Pro 12 before scanning is 
possible from within Microsoft Word (or any registered word processor). 

• Two items will be added to the File menu of the word processor. They are “Acquire 
Text” and “Acquire Text Settings”. 

• Clicking on “Acquire Text Settings” will display an abbreviated OmniPage Pro 12 
Options dialogue box. Not all choices are present. One choice that is not present is 
“Retain graphics”. There is no option to remove graphics so they will always show up 
when scanning in Word (even if graphics have been turned off in the OmniPage Pro 
12 program). 

• Clicking on “Acquire Text” will cause the scanning process to begin. If “Draw zones 
automatically” is checked (Direct OCR / Process Options) the incoming page will be 
zoned, recognized  and displayed in the open Word document 

• Source text may be in columns (make sure Original Layout is set to “multiple 
columns” in OmniPage Pro 12). The columns will be replaced with a properly 
ordered, continuous flow of text. 

• Source material may be scanned upside down or sideways (make sure  
“Automatically correct page orientation” is checked in the OmniPage Pro 12 Options 
dialogue box (Tools / Options / Process).  

• For low vision students the font size can be adjusted (however, graphics will not be 
enlarged making them disproportionate to the text). It may be preferable to use a 
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screen enlarging program which will maintain proper proportions between text and 
graphics. 

The Process 

• Open a “New” Word document. 
• To have Word underline words that are not scanned correctly, choose “check 

spelling as you type” from the Tools/Options/Spelling and Grammar dialogue box in 
Word. This makes it easier to identify misspelled words during clean up. 

• In the “File” menu choose “acquire text settings”. Make settings changes if necessary 
(see General Information) and close the dialogue box.  

• In the “File” menu choose “acquire text”. The scan, zone and recognize process will 
take place in Word. 

• Subsequent scans using “acquire text” from the “File” menu will place text after the 
cursor location in the Word document.  

• After all source material has been scanned into the Word document it may be easier 
to clean up if it has uniform size, font and justification. This will not be appropriate if 
retaining original text attributes is important for the student. To do this, however, 
choose “select all” in the “Edit” menu. This will highlight all of the text in the 
document. Press Control+Spacebar remove all attributes (bold, italics, etc.). Press 
Control+L to left justify all of the text and then choose a size from the toolbar that is 
easy to work with. Press the Up Arrow to remove the highlight and place the cursor 
at the top of the document.  

• Save document regularly. 

 

A “Related Materials” section is included in this resource book.  Please refer to the 
Related Materials section for a list of narrated screen demonstrations that have been 
developed for each content section. All narrated screen demonstration files are included 
on your Accessing Literacy cd, also included with this resource book. 
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SECTION 6 
INDEPENDENT PRODUCTION OF E-TEXT  

USING KURZWEIL 1000 
(WHAT IT IS AND SUGGESTIONS FOR IMPLEMENTATION) 

Introduction 

The module Independent Production of E-text will address the use of the Kurzweil 1000 
program to provide independent access to print. Access can be obtained through the 
use of a scanner or through the importation and recognition of non-editable graphics files 
which contain text. This module will outline the procedure for acquiring and recognizing 
text and it will provide tips and strategies for efficient and successful implementation. 

Description of Student Need 

Students need to access all printed curricular resources that are used in the classroom. 
This includes both textbooks and Teacher prepared materials.  They also need access 
to research materials, both hard copy and online source material.  Beyond that, students 
need an efficient method of organizing, skimming and summarizing these materials. 
Kurzweil 1000 provides solutions for all of these student needs.  Using Kurzweil 1000 
students can access these resources and features in e-text which can then be read in 
hard copy Braille and/or refreshable Braille. 

Assumptions 

• The student creating e-text independently understands what Kurzweil 1000 can do 
and why it would be useful. Furthermore, they have a need and desire to produce e-
text independently. 

• Materials in hard copy will require that the student has an organized way of filing and 
retrieving paper Braille.   

• The student will benefit from the active process of reading, (rather than the passive 
process of listening), therefore the student who utilizes e-text should, whenever 
possible, do so via hard copy (translated) Braille or a refreshable Braille display.  

Prerequisites 

• Students have a working knowledge of the Windows file structure and hierarchy as 
presented in Windows Explorer. 

• Students have a working knowledge of Windows menu and sub-menu structures and 
conventions. 

• Students have a working knowledge of Windows cursor movement commands. 
• Students have a working knowledge of common word processing features 

(specifically, the use of a spellchecker, Find, Replace and Go To commands). 
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Team support needed to setup and implement the independent 
production of e-text 

The student will require sequential instruction in the use of the Kurzweil 1000 program. 
This instruction will start with basic scanning and/or text importation and associated 
reading commands. It will progress through its many features and end with the ability to 
use Kurzweil 1000 as a tool for study skills. 

Classroom Implementation Strategies 

The Kurzweil 1000 program is designed for use outside the classroom. It’s main purpose 
will be to allow the student independent access to print in order to prepare for classroom 
activities and assignments. It will also allow the student to access and organize research 
materials, so that they may be saved and reviewed in an efficient manner. 

Common Barriers or challenges that might occur 

The student will require time to learn the Kurzweil 1000 program in advance of needing it 
to access print materials. The student will also need to be able to get the print materials 
(or existing e-text materials) in order to have source materials to work with.  This may 
involve learning library systems and the ability to do efficient searches for appropriate 
print (or online) materials. 

Equipment Needed 

• Current Pentium computer (256 meg RAM, Windows 98 or higher)  
• Software designed to provide independent access to print materials (i.e. Kurzweil 

1000) 
• Supported scanner (e.g. Epson). Check Kurzweil 1000 website before purchasing 

(www.kurzweiledu.com)  
• Industry standard word processor (e.g. Microsoft Word 2000 or 2002 
• (Optional) Braille Embosser 
• (Optional) Refreshable Braille Display 

FAQ 

1. Kurzweil 1000 appears to only provide speech output. The student prefers 
refreshable Braille. How can I use refreshable Braille with Kurzweil 1000? 

There are two ways you can use refreshable Braille with Kurzweil 1000.  The first 
us by saving your file in one of Kurzweil’s pre-defined Braille notetaker formats 
and then transferring the file to it.  The other is to use it with JAWS and a 
dedicated Braille display.  

When Kurzweil 1000 is opened JAWS goes to sleep, however, its Braille display 
drivers keep working. The display will track the document that is open in Kurzweil 
1000 
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2. Do I need a word processor if I have Kurzweil 1000? 

Kurzweil 1000 has many word processor features and all Kurweil 1000 files are 
text based so they are fully editable. However, a word processor is still 
recommended for its advance formatting features.  

3. Should I use Kurzweil 1000 to provide e-text for the student instead of OmniPage 
Pro? 

There are good reasons to use Kurzweil 1000 as your main OCR program when 
supporting students.  The main ones are: 

a) The choice of 2 recognition engines gives flexibility for speed and accuracy 
needs. 

b) Scan optimization tailors the scanning settings to the individual document to 
ensure the best recognition results. 

c) The low vision student can use image files for on-the-fly magnification 
combined with speech output. 

d) Outlines can quickly be created for the student prior to their reading large 
documents. This gives the student a synopsis of what the source material will 
be about. 

The main drawback to using Kurzweil 1000 for both Braillist and student use is its 
very high price (currently $1595.00). 

Information and Instructions for Kurzweil 1000 
 
Using Kurzweil 1000 for the Independent Production of E-text 

Introduction 

Kurzweil 1000 is a program that allows the blind user to have independent access to: 

• Printed material in books, magazines, newspapers and any other paper publication 
and/or format through the use of a scanner 

• Non-editable text found on computers such as graphic text found on many web 
pages and graphic file formats such as Adobe Acrobat files (.pdf) 

• Any text based file which can be imported for use with the specialized Kurzweil 1000 
features 

All Kurzweil 1000 files are fully, editable text-based documents so information can be 
added to any document, bookmark or summary. 

Kurzweil 1000 is not a screen reader. It does not read the contents of other applications. 
It uses OCR (optical character recognition) technology to create a version of the page 
that it can read aloud. It does not replace a full word processor. 
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Within Kurzweil 1000 the user has access to a variety of settings which allows 
customization of: 

• Voices – there are different voices for text (reading voice) and headings (system 
voice). Voice, pitch and speed can also be adjusted 

• Scanning – there are settings to maximize scans according to the quality of the 
original 

• Recognition – there are settings to identify columns, text colour and quality, as well 
as selecting from two recognition engines 

• Reading – there are different reading units available as well as the ability to advance 
and rewind reading. Punctuation, header omission , and many other reading options 
are available 
 
(Note: this is not a complete list of settings) 

Kurzweil 1000 has a built in dictionary and thesaurus. Words within its dictionary 
definitions and thesaurus choices can also looked up for further explanations. 

Kurzweil 1000 also allows the user to condense large text articles through its browsing, 
summarizing and book marking features. This gives the blind user an efficient ability to 
scan through documents looking for appropriate information. It also useful for creating 
study outlines and guides. 

Kurzweil 1000 can be set to keep image files (the scanned graphics files that were used 
for recognition). This is useful because if the page was poorly recognized the user can 
change the recognition settings and then re-recognize the page (without having to re-
scan the page). 

Kurzweil 1000 can be used to recognize currency. This feature is beyond the scope of 
this document. See the Online Manual for instructions on recognizing currency. 

Kurzweil 1000 can create mp3 files which can be transferred to audio devices for mobile 
access. This feature is beyond the scope of this document (which deals only with the 
creation and use of e-text). See the Online Manual for the creation of mp3 files). 

Kurzweil 1000 can interface with Braille note takers for portable access. 

Using Kurzweil 1000 you can search and retrieve electronic books from three web sites 
(Baen.org, Bookshare.org and Project Gutenberg). This feature is beyond the scope of 
this document. See the Online Manual for instructions on accessing online electronic 
texts.  

How to get E-text into Kurzweil 1000 

1. Text may be transferred into Kurzweil 1000 through the use of a scanner. The 
process is as simple as putting the print document face down on the scanner and 
pressing the scan command (F9). By default Kurzweil 1000 scans, reports on the 
scanning process and then begins reading the document. If the page is put in 
sideways or upside down the orientation is automatically corrected for reading. If it is 

 
Vision Technologies: Access to Literacy - ALT-VI 2003 

Page 104 



Section 6: Independent Production of E-text 

put in face up Kurzweil 1000 reports a blank page. See section “Using Kurzweil 1000 
with a Scanner” for more detail. 

 
2. Text may be imported from any text-based file (Word, Excel, Word Perfect, RTF, text 

file). There are advantages to importing text into Kurzweil 1000 rather than reading in 
the word processor using a screen reading program. They are: 

o Text in Kurzweil can be structured using multi-leveled bookmarks (see the 
section “About Bookmarks”). There are six levels of bookmarks that can be 
created. Bookmarking allows the user to create outlines and get a synopsis of the 
material before reading it for content. Descriptions may be added to each 
bookmark to provide a user defined summary 

o Text may be browsed. That means only the first and/or the last sentence of each 
paragraph will be read. This provides a quick way of skimming through a 
document 

o Text may be summarized. That means its content will be reduced to 10% of the 
original and extracted to a new file (with “summary” added to the file name. You 
can also create a summary document from the bookmarks.  

3. An image file can be transferred into Kurzweil 1000 using the virtual printer (KESI 
Printer that is put into the printer list on). Using this method, files which otherwise 
would not be readable will be recognized and converted into editable text. This is 
useful for: 

o Adobe Acrobat file (.pdf) which otherwise would be detected by the screen 
reader as a graphic and not read 

o Some websites that have text which is really a graphic and not readable using a 
screen reading program 

o Sometimes pages scanned by typical OCR programs will incorporate any text 
which describes or explains a picture, into the picture. When this occurs the 
screen reader will detect it all as graphic, and not read the text that describes the 
picture. Printing it to Kurzweil 1000 may allow you to read the text associated 
with the picture (see the section “More About Image Files” 

Reading and Processing Commands 

Kurzweil 1000 has two ways of executing reading and processing commands. They are: 

1. Using the Numeric keypad. All keys on the keypad have commands assigned within 
Kurzweil 1000. In fact there are three layers of commands. By default the keypad is 
set to the “reading keypad”. Using this layer you press keys to (among other things): 
start and stop scanning; start and stop reading; adjust the volume; adjust the reading 
speed; fast forward and rewind by the reading unit (sentence, line, or paragraph); as 
well as access the dictionary, spellchecker, and online help. The second layer is the 
“file management keypad”. It is accessed by holding down the Shift key and tapping 
Accept key (top right on keypad) until you hear the layer that you want. The “file 
management keypad” allows changes the functionality of the keys to create and 
delete folders, move between folders as well as open, close, delete, and save 
document files. The third layer is the “settings keypad”.  When this keypad layer is 
chosen the keys will let you customize reading and system voices and change some 
scanner settings. Each layer has further options when the Shift key is held down 
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before pressing the buttons on the respective keypad layer. Refer to the manual for 
all keypad assignments for each layer. 
 

2. Using a combination of the Function keys across the top of the keyboard and either 
Shifted Function keys or Control keys (Control + a letter), all reading and processing 
commands can be executed. The basic keys for reading and processing are: F5 
(toggle between continuous reading and stop); F6 (read previous unit); F7 (read 
current unit); F8 (read next unit); F9 (scan page); F11 (slow down reading speed); 
F12 (increase reading speed). Other Function key assignments are: F1 (context 
sensitive Help); F2 (general Help); F3 (Find Next); F4 (Close Document); F10 
(transfers the focus to the menu bar). 

3. Hotkeys for executing commands can be found in the menus beside each item. 

Working with Text in Kurzweil 1000 

• Using Kurzweil you can read by line, sentence or paragraph. To change the reading 
unit open the Settings menu and choose Reading… (as a Windows convention any 
item ending with an ellipsis will open a dialogue box). The Reading dialogue box has 
settings to change the reading unit (see the section on “The Settings Dialogue Box” 
for all of the reading options).  You can also use standard Windows cursor 
movement commands to have text read (see Appendix A for Windows Reading 
Commands). 

• Words can be spelled by pressing Control+L when the cursor is on the word. 

• The Page Up and Page Down keys function differently in Kurzweil 1000. Pressing 
these keys moves the document by physical pages rather than by screens of 
information. That does not mean that all information on the physical page is 
displayed. You may have to arrow down to get to the bottom of the page. Pressing 
Page Up or Page Down moves you to the top of that page (i.e. previous page or next 
page). 

• Using the Go To command (Control+G) you can jump to any page in the document. 
This is fine as long as you started scanning at page 1. If you did not begin scanning 
at page 1 Kurzweil 1000 will assign the first scanned page as page 1 (even though it 
may be page 63 in the book it came from). To adjust Kurzweil 1000 to match the 
page numbers in the hard copy book you must “set page numbers”. To do this open 
the Edit menu and choose “Set Page Number”.  Type the page number that 
corresponds with the page number in the book and press Enter. This synchronizes 
Kurzweil 1000’s page reporting with that of the hard copy book. Numbers will 
continue consecutively until you set a new page number (which you would do if 
pages such as the beginning of a chapter were unnumbered in the print book, or, you 
left out a section and then continued scanning again). The Go To command now 
takes you to the pages that correspond to the source material. 

• Kurzweil 1000 uses two different voices. One, the Reading Voice is used for regular 
text. The other, the System (or Message) Voice, is used for text that is bold, 
italicized, or underlined. This can be useful in helping to understand the structure of 
the document and for setting bookmarks (although level one bookmarks should be 
created from the Table of Contents (see the section “Using Kurzweil 1000  as a 
Study Tool”). 
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• When reading through a document you can access the dictionary at any time. To do 
this put your cursor on a word and press Control+D (or access the dictionary from 
the Read menu. Kurzweil 1000 will say, “The word to be defined is …..”  Press Enter 
to hear the definition. There may be many definitions. Press Enter again (or Alt+N) to 
hear the next definition(s). Press Alt+P to go back and hear previous definitions. 

• When reading through a document you can access the Thesaurus at any time.  To 
do this put your cursor on a word and press Shift+F7 (or access the Thesaurus from 
the Read menu).  Kurzweil 1000 will say, “Synonyms will be found for …..”  Press 
Enter again to hear the first synonym for the word. Press Enter (or Alt+N) again to 
hear the next synonym(s). Press Alt+P to hear previous synonyms. If you want one 
of the synonyms defined you can press Control+D and you will switch into the 
Dictionary and the word will be defined. Note that by doing this you have left the 
Thesaurus. To return to it you must exit the Dictionary (press Escape) and re-enter 
the Thesaurus by pressing Shift+F7 again. 

Getting Help in Kurzweil 1000 

• Pressing F1 provides context sensitive help wherever you are in Kurzweil 1000. This 
includes all of the controls in a dialogue box 

• Pressing F2 provides general help about the kind of environment you are in (e.g. 
general information about what a dialogue box is). This help is not always available 
(e.g. on a menu item) 

• Using the Help menu you can: 

1. Get information about the Reading Status. This gives all of the current 
reading settings 

2. Get information about the Settings Status. This gives information about a 
wide variety of current scanner and process settings 

3. Open the Manual.  The Kurzweil 1000 Online Manual is a searchable, text 
based document. Information may be obtained from the Manual in 2 ways. 
The first is by using Kurzweil 1000’s bookmarking features (see the section 
“About Bookmarks”). The Manual has been pre-bookmarked so pressing 
Control+R (or access bookmarks from the Read menu) will bring up a 
dialogue box of chapter bookmarks. Each chapter bookmark is broken down 
into sub-heading bookmarks to access specific features within each chapter 
(see the section “Creating and Using Bookmarks”). The second way to use 
the Online Manual is to search it by keywords. This is useful if you wish to 
follow a keyword throughout the manual. To search the Online Manual press 
Control+F (or access Find through the Edit menu). To find the next 
occurrence of the keyword press F3. Note that the Online Manual remembers 
where you were last and opens to that place. Searching a new keyword will 
begin from there unless you move to the beginning of the Online Manual 
when you begin a new search using the Find command. 

Note that this Find command is not restricted to the online manual. It 
can be used in any scanned or imported document. 
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Using Kurzweil 1000 with a Scanner 

Kurzweil 1000 is an OCR program that is specifically designed to simplify the scanning 
and reading process for users who are blind. Using the scan (F9) and read keys (F5, F6, 
F7, and F8) users can instantly create and read e-text. As you become more familiar 
with the program you will find that it contains many intermediate and advanced features 
to control the scanning process and improve its efficiency. By default, Kurzweil 1000 
scans, recognizes the text and then automatically begins reading it to you.  

As previously stated Kurzweil 1000 automatically corrects the page orientation. Reading 
in Kurzweil 1000 is a separate process from scanning so you can stop the reading (F5 or 
Control key) and continue scanning (F9) if you have many pages to do. It is also 
possible to scan one document while reading another. Kurzweil 1000 can keep track of 
two documents at the same time and differentiates between the scanning and the 
reading document (if they are different). It will append a new scan to the scanning 
document even though you may be reading another document. 

• Scanned pages are, by default, placed at the end of the document that you are 
scanning. If you want them placed in front of the current scanned page open the 
Scan menu and choose “Insert Page”.  

• If you want to scan two pages at a time (such as with a paperback novel) open the 
Settings menu and choose Recognition. In this dialogue box change the Two Page 
listbox to show “Two Pages” (it is set to “One Page” by default). 

• You can have Kurzweil 1000 scan automatically without pressing the scan key (F9). 
To do this, set the time between scans in the Settings menu (choose Scan). Then 
press Shift+F9 and scans will occur automatically with whatever delay that you set 
between scans. To cancel the automatic scanning process press F9 (or choose 
“Cancel Scan” from the Scan menu). 

• You can also have Kurzweil 1000 just scan pages and have them recognized later. 
However, if you are using a current computer system, this is unnecessary as the 
page will typically be recognized before you can put a new page on the scanner so 
there is no savings in efficiency or time. For information on how to do this please 
refer to the Program Manual. 

• Scanner settings can be adjusted to optimize the results for reading accuracy. These 
settings are made in the Settings menu under Scanning. The main setting that can 
be adjusted are: (see section Tips for Scanning in the Online Manual for more detail). 

1. Thresholding – the way the pixels on the page (the tiny dots that make up the 
characters) are interpreted for recognition. The choices are static, dynamic, 
grayscale, and colour.  Static is the default 

2. Brightness – the darkness or lightness of the overall image before recognition 
is determined on a scale of 1 to 100. The default is 50 

3. Resolution – This is related to font size and the ability to make it legible in the 
image file. The default resolution is 300 dpi (dots per inch). Raising the 
number will increase legibility for poorly recognized letters, but it will slow 
down the scanning process 

• Kurzweil 1000 has an option in the Scan menu to “Optimize Scanning…”  Choosing 
this brings up a dialogue box where you can have the program determine the best 
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settings for you by choosing to have all or any of them optimized. Kurzweil 1000 will 
make repeated scans over the page to determine the best settings. This is especially 
useful before you start a long scanning job where the pages are consistent in their 
quality. It will ensure that you have the best settings before you start. 

About the Recognition Process 

Creating readable text is the product of two processes. The first is the scanning process 
which was described above. This process creates an image file for each page of the 
source material. This image file is graphical and non-editable. By default the image file is 
discarded when the recognition process is completed. There are many good reasons to 
keep image files as will be discussed later. The second process is recognition. This 
process turns the image file into readable, editable text. Recognition results determine 
the quality of the final document. 

• Kurzweil 1000 has two recognition engines to choose from. The first one (the default) 
is the RTK engine. It is faster than but not as accurate as the other one (FineEngine). 
RTK supports many languages and works best for numbers. The other recognition 
engine is FineEngine. It is somewhat slower the RTK engine but is considerably 
more accurate. It also supports many languages. FineEngine supports grayscale 
scanning while RTK does not.  If recognition is poor, consider changing the 
recognition engine to FineEngine first. To do this open the Settings menu and 
choose Recognition. Change the recognition engine in the Engine listbox. 

• Re-recognition may be necessary if the results were poor. It is usually more 
convenient to re-recognize a page than it is to re-scan it.  To re-recognize a page 
open the Scan menu and choose Re-recognize Page. There are many settings to 
improve recognition, but first the image file must be kept (remember that it is 
discarded by default). To keep the image, open the Settings menu and choose 
General. Change the Keep Images listbox to “Enabled”. Now pages will be available 
for re-recognition. The main changes that can be made to improve accuracy during 
re-recognition are found in the Settings menu under Recognition. These changes 
are: 

1. Change the recognition engine to FineEngine. Some users keep this as the 
default because of its superior recognition ability. 

2. Identify columns – it is best to keep this enabled in case there are columns on 
the page. 

3. White on Black – it is best to keep this enabled in case there is inverted text on 
the page. 

4. Speckle Removal – This filter looks for small, stray, or random dots on the page 
and eliminates them from the image. Use with caution, though, as the speckle 
removal filter may impair recognition of very small text. It also adds slightly to the 
recognition time. 

5. Text Quality – It defaults to “normal”. Use “degraded” only if the text quality is 
very poor as it can impair the recognition quality of normal text. Use Draft Quality 
for dot matrix printers. 

6. Partial Columns – This setting has two values, Kept and Ignored. Kept is the 
default. Ignore means that text (less than 2 inches wide) which overlaps the 
scanner glass (e.g. from the second page of an opened book) will be ignored. 
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However, it will also ignore narrow columns on a single page that are positioned 
close to the edge. It is only useful if you know you are scanning something that is 
wider than the scanner. 

Using the Recognition Statistics to Improve Scanning 

Kurzweil 1000 tracks and provides the recognition statistics for the last page scanned as 
well as all pages scanned. (All pages is cumulative in that it includes all of the 
documents ever scanned using Kurzweil 1000, however, it can be reset to zero.) 

Kurzweil also tracks poorly scanned pages. To access this information open the Tools 
menu and choose Recognition Statistics. This lets you review a breakdown of important 
aspects of the recognized image. The recognition statistics provide valuable information 
on the accuracy of the scan and by doing so provides information on how to improve it 
during re-recognition. Specifically it tracks:  

• The speed of the scan. This is the amount of time it took Kurzweil 1000 to convert 
the page image into characters. The higher the number the easier it was to convert, 
therefore, the better the recognition accuracy.  

• The confidence level of the recognized image. The confidence level is a threshold 
measured in a percentage. There is a confidence level for every page image. The 
confidence level takes into account the number of characters scanned, the number 
of illegible characters, and the number of questionable characters. The higher the 
percentage the more confident Kurzweil 1000 is regarding the accuracy of the 
recognition process for each page image. This useful for many reasons. They are: 

1. It tells you right away whether or not you need to make scanner or recognition 
adjustments before proceeding. Typically a confidence level below 90% means 
there were many errors in recognition. Ideally you want a confidence level above 
96%, but anything above 90% should be quite readable. Note that the confidence 
level is a statistically manufactured number, so its reliability will vary. It reflects 
letter recognition accuracy, best on pages that are pure text, with no diagrams or 
stray lines to confuse it. 

 
2. You can manually set the confidence level for “poorly scanned pages”. Those 

images will then be kept for re-recognition. To set the confidence level for “poorly 
scanned pages” open the Settings menu and choose General. Change the Keep 
Images listbox to “Poorly Recognized Pages”. Then open the Tools menu and 
choose Recognition Statistics. From the sub-menu choose “Poorly Recognized 
Pages”. Set the confidence level (typically to 95%). Now any page images that 
are recognized with a confidence level below 95% will be kept. Those page 
images that are at or above 95% will be discarded. To access the poorly 
recognized pages for re-recognition, open the Tools menu and choose 
Recognition Statistics. All page images that were recognized with a confidence 
level below the value that you set (in this case 95%) will be listed in ascending 
order (i.e. the worst first). These images can be opened for re-recognition by 
Tabbing to the list and pressing Enter on them. Before re-recognizing the pages 
make changes to the options in the Recognition dialogue box by opening the 
Settings menu and choosing Recognition. 
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• The number of illegible characters.  These are blobs that Kurzweil 1000 cannot 
recognize as any letter. The greater the number of illegible characters the worse the 
quality of the source document. De-speckling may help in re-recognition. 

• The number of questionable characters. These are the number of letters that 
Kurzweil 1000 guessed at. A high number indicates that you may want to switch to 
FineEngine. 

• The number of touching characters. This is the number of characters that Kurzweil 
1000 separated to make into proper letters.  It is related to the brightness setting of 
the original scan. A high number of touching characters means you should raise the 
brightness setting (found in the Settings menu under Scanning). 

• The number of broken characters. This is the number of separated characters that 
Kurzweil 1000 joined together to make proper letters.  This is also related to the 
brightness setting of the original scan. A high the number of broken characters 
means you should lower the brightness setting. 

• The elapsed time. This is the time it took for all of recognition processes except the 
time it took to physically scan the page. The lower the elapsed time, the better the 
accuracy of the recognition process. 

• The number of automatic corrections. This will tell you how many words were 
automatically corrected by Kurzweil 1000 (see the section “About Automatic 
Corrections”). 

About Automatic Corrections 

Automatic corrections is a permanent list of corrections contained within the Kurzweil 
1000 program. Kurzweil 1000 automatically applies these corrections whenever it 
matches a misrecognized word with one of its corrections when Automatic Corrections is 
enabled. To enable it, open the Setting menu and choose General. By default the 
Automatic Corrections listbox is set to Enabled. If you set it to Disabled you must 
manually Apply Corrections from the Tools menu.   

You can view the extensive (default) list of corrections from the Tools menu by choosing 
Edit Corrections. You can edit this list (e.g. add to it). Since this is a permanent list, all 
corrections (both those that are native and those you add) will be applied to every future 
scan. To add words to the default corrections list: 

1. Open the Tools menu and choose Edit Corrections. 
2. Press the Add Word button, type the exact misspelling and press OK. For 

example you might add “pu!!” which has shown up instead of the “pull”. 
3. The misrecognized word (“pu!!”) is now added and focus has moved to the 

“Replace With” edit field. Type the correct word (“pull”) and press Enter (activates 
the OK button). 

4. Now in future, if Kurzweil 1000 misrecognizes the word “pull” by recognizing it as 
“pu!!” it will automatically correct it. 

You can also create user-defined corrections lists that are separate from the 
default list. To do this see the Editing chapter in the Online Manual. 
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When you use Ranked Spelling in conjunction with the Automatic Corrections 
feature, you can improve the accuracy of the pages you scan (see the section on 
“Ranked Spelling”). 

Ranked Spelling 

Ranked spelling provides statistics on the misspelled words in the entire document. It 
tells the percentage of correctly spelled words and the number of misspelled works. This 
in itself can be useful information about accuracy of the recognition. However, keep in 
mind that a word is only considered misspelled if it is not found in Kurzweil 1000’s 
dictionary. Documents with a lot of jargon, names and/or unconventional words will 
decrease the percentage of words spelled correctly in the Ranked Spelling dialogue box 
without necessarily reflecting on the accuracy of the recognition process. Misspelled 
words are presented according to frequency, i.e. the one with the greatest frequency is 
at the top of the list. Commands for correcting the misspelled words are provided in the 
same dialogue box. The most useful ones, after you have corrected the word (by 
choosing from the list of suggestions or manually typing it in) are, Add to Word List and 
Replace All. Press the Apply button (Alt+P) to add words to the dictionary and re-
generate the Ranked Spelling list. Press Enter to apply changes (to both dictionary and 
the document) and exit the Ranked Spelling dialogue box. 

If you find a word with a high frequency occurrence, you can copy and paste it into the 
Add Word edit field of the Edit Automatic Corrections dialogue box. Type the correct 
spelling and that correction will be applied to all future scanning jobs.   

More About Image Files 

As previously discussed, image files are useful for re-recognition. Changing recognition 
options before re-recognizing can often improve the readability of the final document. 
Kurzweil 1000’s image files have other uses as well. To view the image file for the 
associated page, press Control+W. To close the image file and return to the recognized 
page press Escape or Alt+F4.  “Keep Images” must be enabled for page images to be 
displayed (Settings menu, choose General). The image files used this way are mainly 
useful for users who have some vision. These features are: 

• The ability to magnify text on the fly. Hold down the control key and press the Up 
Arrow and Down Arrow keys to increase and decrease the magnification of the 
image. (Note: The text can also be magnified without going to the image file by 
opening the Settings menu and choosing Display. A fixed magnification level can be 
set here, it cannot be changed on the fly however.) 

 
• The ability to have Kurzweil 1000 read the text from the image file. Kurzweil 1000 will 

read the text in the image file by pressing F5. Depending on the way the image file 
was created during the scan, Kurzweil may block the reading unit in yellow (by 
default) and then track the word in blue (by default). This, combined with 
magnification, can be an effective reading aid for low vision students who benefit 
from large print, tracking and speech feedback. When in the image file the position of 
reading and tracking is tied to the location of the cursor on the recognized page so if 
you switch to the image file half way through the page, it will begin reading from the 
location of the cursor on the recognized page even though the it may not be visible 
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on the screen (i.e. when magnification is set high and the cursor is towards the end 
of the recognized page. Because it is an image file there is no cursor to move and so 
the only way to make sure it reads from the beginning of the image file is to move the 
cursor to the beginning of the recognized page. (Note: Kurzweil 1000 will also track 
the word (in blue by default) as it reads from the recognized page by pressing the 
reading key, F5. It does not, however, highlight the reading unit. Again, word tracking 
combined with magnification can be an effective reading aid for low vision students.) 

 
• Reading from image files can be useful for blind users because Kurzweil 1000 may 

find text contained within, beside or under a graphic that otherwise would not have 
been recognized (because it was associated with the graphic during recognition). 
This may allow users access to information about graphics. 

Using Kurzweil 1000 as a Study Tool 

Kurzweil 1000 has many features that assist the user for research, and organization of 
source material through the creation of bookmarks. It also has features to increase 
reading efficiency through summarizing and browsing. 

About Bookmarks 

Kurzweil 1000 has six levels of bookmarks that can be set. In order to create useful 
bookmarks it is important to understand the structure of the source document. If you 
want to create bookmarks based on headings, for instance, you can: 

• Search for bold text (this is an option in the Find dialogue box).  Press Control+F to 
open the dialogue box and F3 to Find Next occurrence 

• Search for centered text (also an option in the Find dialogue box 
• Use context to determine if it is a heading (e.g. is there a blank like above and/or 

below it) 
• If you want to create bookmarks based on vocabulary or keywords you can search 

by italicized, bolded or underlined text (all available in the Find dialogue box). Since 
documents retain their structure throughout, initial sighted assistance may be a 
useful time saver 

In addition to creating bookmarks so that you can quickly go to a particular place in a 
document, they can also be used to: 

• Create a hierarchy of the headings and sub-headings in order to provide a synopsis 
or snapshot of the contents of the source material. 

• Link the Table of Contents to the chapters. 

• Provide a description of the bookmark. By default the word or sentence associated 
with the bookmark (depending on whether the cursor was on a word in a sentence or 
on a heading) was will be added to the “Description” field within the Bookmarks 
dialogue box. However, selected text may be added or you can Tab to the 
Descriptions field and write your own description. Note that if you edit the 
Descriptions field, the bookmark title will change with it.  The Kurzweil manual gives 
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the impression that you can edit the description independently from the title but they 
both change together. 

• Have sounds (chimes) alert you to their presence when re-reading a document. If 
you have re-written the description with your own notes you can jump to these notes 
as you read through the document (see the section “Utility of Boomarks”). 

• Have bookmarks extracted into a summary document (it will be a separate file in rich 
text format .rtf). By doing this you can create a multi-level outline. Since this is a text 
based document, the student can enter important notes or points within the extracted 
bookmark summary. This can then act as an effective study guide. 

Creating Simple Bookmarks (Level 1 only) 

1. Put your cursor on the word that you want to bookmark and press Control+B. A level 
1 bookmark will be created.  

2. Go through and bookmark each important heading, word or phrase that you want to 
be able to quickly jump to. 

3. To jump to your bookmarks, press Control+R and Bookmarks dialogue box will open. 
Tab and Arrow to the bookmark you want to open and press Enter. Kurzweil 1000 
will immediately jump to the bookmark location in the file and begin reading. 

Creating Multi-level Bookmarks (Levels 1 - 6) 

You can make as many bookmarks as you want within the document.  Within the 
Bookmark dialogue box you can set a chime alert to signal the presence of your 
bookmarks (and associated descriptions) when re-reading the document. When the alert 
sounds you can go to the bookmark to retrieve the information that you have inserted in 
the bookmark description. This is one way to access your own notes as you read 
through a document. 

To create multi-level bookmarks: 

1. Place your cursor where you want the bookmark and press Control+B. By default 
it will become a Level 1 bookmark. For this example we will assume the cursor is 
on a main heading. If the chapter headings have already been bookmarked as 
Level 1, Tab to the Level listbox and change it to Level 2. 

 
2. Press Control+B a second time to edit the description (if you want, keeping in 

mind that the bookmark title will change accordingly). 
 

3. Place your cursor on the next bookmark location (within the chapter and press 
Control+B again. For this example we will assume that the cursor is on a sub-
heading.  Tab to the Level listbox and change it to Level 3. 

 
4. Go through the chapter and find all sub-headings and bookmark them as Level 2 

as well.  (Edit descriptions if you want.) 
 

5. You could, as you go through the section, look for important vocabulary words 
and bookmark them as Level 4 (editing the descriptions to include the 
definitions).   
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6. To open the bookmarks after you are done, press Control+R to bring up the 
Bookmarks dialogue box. It present the levels in a typical Windows treeview 
hierarchy where you would expand and collapse the levels using the Left and 
Right Arrow keys. To move up and down in a level by press the Up and Down 
Arrow keys. 

Utility of Bookmarks 

• You can create a summary file of your bookmarks by opening the File menu and 
choosing Summary. You will be asked if you would like to use Bookmarks to create 
the summary. Press “Yes”. You will be asked if you would like to keep Page 
Numbers in the summary. Press “Yes” if this is important. A new Kurzweil 1000 
document will open. The document is in outline form. Each bookmark as a line and is 
prefaced with a number, such as 1 or 1.1 or 1.1.2 depending on the level.  The page 
number for the bookmark follows the description in parenthesis (if you chose to keep 
page numbers). This summary file provides a useful outline of the source document. 
Notes can be added to the Bookmark summary to create a study outline (Note: you 
can have Kurzweil 1000 summarize a document on content as well as bookmarks – 
see the section “Summarizing Information”). 

• Outlines created using bookmarks can be copied and then pasted into a word 
processor (use Paste Special to retain the hierarchical structure) if you would rather 
use your word processor for study guides and outlines. 

• The process of creating bookmarks provides many benefits for the student. The main 
ones are: 

1. On their own, multilevel bookmarks provide an organized synopsis of the source 
document. 

 
2. It provides a starting point for the creation of study outlines and guides. 

 
3. When the chime alert is activated you can access user-created notes as you re-

read a document. These notes would be info that you wrote into the description 
field as you created the bookmarks.  Keep in mind that the bookmark title will 
change when you edit the description.  This is a separate use for bookmarks 
other than allowing quick access to a section or creating study guides based on 
bookmarks, and should not be confused with it (because the bookmark title 
changes). Used this way the bookmarks only use is to access your own notes at 
particular points in the document. 

 
4. The most important benefit is that by creating multilevel bookmarks, students 

become familiar with where information is found in the source document, and 
more importantly with the topics and sub-topics within the source document.  
This is a much more efficient and dynamic method of learning than simply 
reading a document from beginning to end. 

• Power users of Kurzweil 1000 have found that bookmarking is most efficiently used 
when the Table of Contents is used for Level 1, Headings are used for Level 2, Sub-
headings are used for Level 3, and Vocabulary or Keywords are used for Level 4. 
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• New users will benefit from the opportunity to experiment with a gradual introduction 
to multi-level bookmarking. 

Summarizing Information 

As well as making summaries based on bookmarks, you can also have Kurzweil 1000 
create a summary of the recognized document. Press Enter in the Summarize dialogue 
box (rather than Yes to summarize bookmarks) and Kurzweil 1000 will reduce the 
document to about 10% or its original size and attempt to retain the salient points. Each 
point will be on a separate line.  If you wish to add your own information to the summary 
simply type the information into the appropriate place in the summary.  This is very 
useful, but should be reviewed to ensure that it does, in fact, maintain the most important 
points.  

Browsing 

Browsing is a feature of Kurzweil 1000 that allows a student to skim through a document 
by having the program read the first and/or the last line of each paragraph. To Browse a 
document press Shift+F5. Browsing provides a quick overview of the document.  When 
browsing make sure you are at the beginning of the document. 

Conclusion 

Kurzweil 1000 is an OCR program designed to give students access to text based 
information that would not otherwise be available. Beyond that it provides a dynamic 
working environment that facilitates the organization and the efficient retrieval of 
information that goes beyond typical word processors and OCR programs. 
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GLOSSARY OF TECHNOLOGY TERMS 

with content focus on technology for persons with visual impairments 

ASCII: ASCII (American Standard Code for Information Interchange) is the most 
common format for text files in computers and on the Internet. In an ASCII file, each 
alphabetic, numeric, or special character is represented with a 7-bit binary number (a 
string of seven 0s or 1s). 128 possible characters are defined. ASCII was developed by 
the American National Standards Institute (ANSI). 

Braille Display: A Braille display is a device, typically attachable to a computer 
keyboard, that allows a blind person to read the contents of a display one text line at a 
time in the form of a line of Braille characters. Each Braille character consists of six or 
eight movable pins in a rectangular array. The pins can rise and fall depending on the 
electrical signals they receive. This simulates the effect of the raised dots of Braille 
impressed on paper. There are usually 40, 65, or 80 arrays (characters) per line of text, 
depending on the device.  

Braille Embosser: A piece of hardware or peripheral which prints the output in braille.  
Braille embossers connect to a computer or other device in the same way a print-
producing printer does.  The embosser uses pins to push braille dots into a special 
braille embosser paper. 

Braille Keyboard: Any keyboard set up to represent the braille cells and space bar.  
Braille keyboards are modelled on the original Perkins Brailler.  On a QWERTY 
keyboard, the letters a, s, d, and j, k, l, can be set up to be used as dots 1, 2, 3, and 4, 5, 
6, respectively.    

Braille Input: A hardware device that allows input to the computer via a Braille style 
keyboard or specific keys on a standard keyboard that function in Braille patterns. 

Braille NoteTaker: A Braille note taker is a portable computer or personal data 
assistant that has a Braille display built onto it. These devices can be used in a stand-
alone mode for taking notes, doing basic word-processing, scheduling appointments and 
performing other tasks. They can also be connected to a computer with screen reading 
software and act as a Braille terminal. 

Braille Output: A hardware device that produces hard copy Braille or paperless, 
refreshable Braille as output from the computer. 

Braille Translation Software: Software which is designed to translate text into braille.  
It translates documents produced in a word processor into a format which can be sent to 
a braille embosser.  As well, if text is entered in braille, the translation software can 
translate it so that it can be printed on a printer. 

Download: To copy something from a primary source to a more peripheral one, as in 
saving something found on the Web (currently located on its server) to diskette or to a 
file on your local hard drive. 
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eBooks: An eBook is an electronic file that allows readers to enjoy novels on their PC, 
laptop or handheld device. Generally, eBooks are formatted identically to printed 
editions, and several manufacturers now offer dedicated handheld eBook devices that 
can store numerous eBooks at one time. This offers the reader the benefit of portability 
and convenience.  

eText (Electronic Text): Textual information stored in a digital form that can be 
presented on a computer screen. Normally this can also be presented in braille or as 
enlarged characters on a computer screen.  

Electronic text, is a computer readable electronic file that may be a duplicate of a 
physical, print text such as a textbook. There are many types of e-text including ASCII or 
Text (.txt), Rich Text Format (.rtf), Word Perfect (.wpd) and Word (.doc).  Students who 
are proficient with computer technology can create their own e-text using a scanner and 
appropriate OCR software (e.g. Arkenstone Open Book or Kurzweil 1000). 

Extension: In Windows, DOS and some other operating systems, one or several letters 
at the end of a filename. Filename extensions usually follow a period (dot) and indicate 
the type of file. For example, this.txt denotes a plain text file, that.htm or that.html 
denotes an HTML file. Some common image extensions are picture.jpg or picture.jpeg or 
picture.bmp or picture.gif 

Internet: The vast collection of interconnected networks that all use the TCP/IP  
protocols and that evolved from the ARPANET of the late 60’s and early 70’s. An 
"internet" (lower case i) is any computers connected to each other (a network), and are 
not part of the Internet unless the use TCP/IP protocols. An "intranet" is a private 
network inside a company or organization that uses the same kinds of software that you 
would find on the public Internet, but that is only for internal use. An intranet may be on 
the Internet or may simply be a network.  
Link: URL imbedded in another document, so that if you click on the highlighted text or 
button referring to the link, you retrieve the outside URL. If you search the field "link:", 
you retrieve on text in these imbedded URLs which you do not see in the documents. 

Online:  Online is the condition of being connected to a network of computers or other 
devices. The term is frequently used to describe someone who is currently connected to 
the Internet. 

 A device such as a printer is online when it is turned on and accessible to a computer. 

Operating System: An operating system (sometimes abbreviated as "OS") is the 
program that, after being initially loaded into the computer, manages all the other 
programs in a computer. The other programs are called applications. The application 
programs make use of the operating system by making requests for services through a 
defined application program interface. In addition, users can interact directly with the 
operating system through a user interface. 

Optical Character Recognition (OCR): A technology that allows the user to scan a 
printed page (with a scanner), analyze the printed text, recognize the letters or other 
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characters, and store this information as a computer text file that can be manipulated  
through a word processor or text editor.  

With adaptive software the document created can be read by a screen reader or as hard 
copy produced in either braille or print. 

PDF or .pdf or pdf file: Abbreviation for Portable Document Format, a file format 
developed by Adobe Systems, that is used to capture almost any kind of document with 
the formatting in the original. Viewing a PDF file requires Acrobat Reader, which is built 
into most browsers and can be downloaded free from Adobe. 

Peripheral: A piece of hardware that is located outside the main computer.  It usually 
refers to external items such as printers, embossers, or scanners. 

Refreshable Braille Display: On a piece of technology, a braille display is a line of 
braille produced with six or eight plastic dots, sometimes called pins, to represent the 
dots in a braille cell.  The pins move up and down to present the text on the screen of a 
computer or the information entered in a braille notetaker. This display is sometimes 
referred to as “refreshable” braille. 

Scanning (definition 1 of 2): A flatbed scanner with software is used for importing 
printed (hard copy) information into the computer to be viewed, and/or magnified. This 
process is referred to as scanning. 

Scanning (definition 2 of 2): "Switch Access" Scanning 
Scanning is an alternative to accessing the keyboard and mouse. This is a slow, but 
functional alternative for individuals with significant physical limitations. Switch access 
uses one or more switches to select from an electronic (set) of graphic images, symbols, 
and/or alphanumeric characters. The individual only needs to have consistent control of 
one or more anatomical sites for accessing a single switch, or multiple switches.   

Not to be confused with a flatbed scanner for input. 

Screen Magnification: A screen magnification program enlarges the image on screen. 
It is useful to magnify the text and graphics on the screen for users who require large 
text and graphics. Most magnification programs have variable magnification levels (from 
2 times to 16 times). Some have split-screen viewing of magnified and unmagnified 
windows. Speech capabilities may also be included in screen magnification applications. 
Speech capabilities may include the ability to echo typing, control caret reading, and 
launch document or application readers. 

Screen Reader: A program which speaks the contents of the computer's screen via a 
speech synthesizer. Such a program is usually also equipped with a system that allows 
the user to "navigate," or find his or her way around the screen, without the necessity of 
seeing the screen.  
 
Tactile Image Device: A device used in the production of embossed diagrams or 
images which can be interpreted tactually.   The tactile image is created by using a 
special heat sensitive paper which has the image drawn on it and is then passed through 
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the tactile image device.  This creates a raised outline of the image.  The Tactile Image 
Enhancer is an example of a tactile image device. 

Text-to-Speech: Software (Also known as Talking Word Processors or Text Readers) 
designed for individuals with reading difficulties. Simultaneously highlights and reads 
aloud text documents. Text readers primarily read aloud text as it is keyboarded, and 
reads aloud text within documents such as e-mails, word processing documents, and 
other electronic text format. This type of software applications are more likely to be used 
by people with learning disabilities, people with poor reading abilities, and ESL (English 
as Second Language).   

Text-to-speech (text reader) applications should not be confused with screen readers. 

URL: Uniform Resource Locator. The unique address of any Web document. There is a 
logic to layout of a URL:  

Anatomy of a URL:  

(e.g. http://www.lib.berkeley.edu/TeachingLib/Guides/Internet/FindInfo.html 

http: 
Type of file (could say ftp:// or telenet:// ) 

www.lib.berkeley.edu 
Domain name (computer file is on and its location on the Internet) 

/TeachingLib/Guides/Internet 
Path or directory on the computer to this file 

FindInfo.html 
Name of file, and its file extension (usually ending in .html or .htm) 

Word Processor: A type of applications software that is used to enter, edit, manipulate, 
and format text. In order to be considered a word processing program rather than a 
simple text entry and editing program, a program should have fairly sophisticated 
capabilities.  
___________________________________________________________ 

Technology definitions have been collected with permission from numerous sources 
including these web sources: 

Special Education Technology – British Columbia 
http://www.setbc.org 

WhatIs.com 
http://whatis.techtarget.com/ 
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RELATED MATERIALS 

SET-BC has produced narrated screen demonstrations for each AT application 
presented in the Access to Literacy (ALT-VI) Preconference sessions.  The 
demonstrations clips are included on the Access to Literacy resource cd.   

We hope you enjoy the resources that SET-BC has developed to record and enhance 
training. Use the Camtasia Player to view the narrated screen demonstrations clips.  The 
Player is included on the Access to Literacy resource cd.  

Demonstrations – Screen Captures 

Software Title  Title of Demonstration Clip 

Write Out:Loud 1. Opening Compatible Files in WOL 
 2. Saving As A Text File (.txt)      

ZoomText 8.0 1. ZoomText AppReader 
2. ZoomText DocReader 
3. ZoomText Speech and Echo Features  

Kurzweil 3000 1   Launching Kurzweil, User Accounts & Tip of the Day  
2  The Kurzweil Window 
3  Customizing Kurzweil Toolbars & Toolbar Sets 
4  Four Ways to Access Kurzweil Tools 
5a   Scanning Single & Multiple Pages 
5b   Reordering Scanned Pages 
5c   Setting Scanning Options 
6   Using the Zone Editor  
7   Correcting the OCR  
8   Importing Documents into Kurzweil  
9   Reading Documents  
10   Using Kurzweil Reference Tools  
11   Using Kurzweil Highlighting Tools  
12a  Adding, Deleting & Moving Notes  
12b Special Features of Notes  
13 Using Bookmarks  
14 Writing with Kurzweil  
15  Using Kurzweil with Forms, Worksheets & Tests 
 

BrailleNote 32 1. Using The BrailleNote and Active Sync 
2. Saving Internet Info as a Text File 
3. Using the PC as a Visual Display 
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JAWS 1. Windows – Mouse Free 
2. JAWS and Word 
3. JAWS and the Internet 
4. JAWS and Grolier’s Encyclopedia 

OmniPage Pro 12 1. OmniPage Desktop 
 2. ImagePanel TextEditor DocManager 
 3. Automatic Processing 
 4. Manual Processing 
 5. About Zones 
 6. Scanning Into MSWord 

Kurzweil 1000 1.Getting Text Into K1000 
 2. The Reading Commands 
 3. The Recognition Process 
 4. Using Image Files 
 5. Getting Help 
 6. Using K1000 as a Study Tool                                                                          
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